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Oops! and Legal Stuff  

 

While I have made every effort to ensure the accuracy of this document, including grammar and 

instructions, I make mistakes. (Surprise!)  If you find an error or want to provide constructive 

feedback, please contact me.  Thank you!  Enjoy Excelling at Excel and this document. 

 

Greg Creech 

Techedutainment Services, Inc. 

P. O. Box 1431 

Pine Lake, GA  30072 

www.gregcreech.com 

 

✓ International Association of Administrative Professionals Member/Partner 

✓ Association of Talent Development 

✓ Society for Human Resource Management 

✓ Microsoft Certified Application Specialist – Instructor 

✓ Certified Technical Trainer + - CompTIA 

✓ A+ Certified through CompTIA 

✓ Microsoft Certified Technical Trainer 

 

Excel ® is a most excellent product from Microsoft ® Corporation and is part of the Office ® 

Suite of products and services.  

 

Copyright © 2018 Greg Creech, Techedutainment Services, Inc.  All rights reserved.  This 

publication, or any part thereof, may not be reproduced or transmitted in any form or by any 

means, electronic or mechanical, including photocopying, recording, storage in an information 

retrieval system, or otherwise, without express written permission of Greg Creech, P. O. Box 

1431, Pine Lake, GA  30072-1431, www.gregcreech.com. 

http://www.gregcreech.com/
http://www.gregcreech.com/
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Introducing Greg Creech 

Shop Talk from The Atlanta Journal-Constitution 
Sunday, Oct. 29, 2000 R3 - JOBS 

Why I Love my Job – Greg Creech 
What I Do: I teach technology courses and make presentations to beginner and expert computer 

users and professionals.  I use humor and the piano.  I train all levels from first-time computer users to 

systems technicians acquiring A+ certification.  As an A+ 

certified trainer, MOUS expert, and technical trainer, my 

certifications and knowledge give me a career in the 

technology.  My humor, the piano, and people keep me in the 

technology training field. I sing to my students sometimes and 

perform stand-up comedy about computers. 

How I got started:  I won Best Actor in a Supporting Role at 

Southside Theatre Guild for “A Funny Thing Happened on the 

Way to the Forum” and studied comedy under Jerry Farber.  I 

have played the piano since 8 years of age and had the first 

personal computer with a 1 MB of memory.  In order to learn 

the PC, I associated the PC with the piano  -- both use a 

language to translate, both have keyboards, and now - both 

provide music and information.  I must admit I miss the days 

when I only played the piano and programmed the PC.  Now, I 

play the PC and have to program my piano.  In 1998 after 

seventeen years of technology business experience in the 

corporate market, I decided to take a leap of faith on my own. 

I call my presentations “Showminars,” a combination of a 

show and a seminar. 

The Best Part:  Hearing the laughter and the comments:  

“You have saved me so much time,” and “I remember 

complicated macros because of the way you taught them.” I have a passion for 

teaching creative people to be more technical and technical people to be more 

creative – Mozart would be proud! 

The Challenging Part:  Explaining why I want my piano in a PC classroom.  

“Mainframers” who refuse to acknowledge the existence of the PC and the 

Web.  People who attend training classes because they have to, not because 

they want to.  Technical people who are not client- focused. 

My Favorite Quotes:  “To err is human, to really mess things up you need a 

computer.”  “Forty-two percent of all households have a computer; only eight 

percent of those know how to use it.”  

What Keeps me Going:  I enjoy combining my love of people, the piano, processors, and humor into a 

unique speaking and learning experience. 

  

Technology  

speaker and  

trainer Plus, 

he’s a   

pianist and 

comedian. 
 

Greg Creech 
sings to his 
students, and 
often he performs 
stand-up comedy 
about computers. 
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My Favorite Excel  Shortcuts  

Keyboard  Shor tcu t  What  i t  Does  

CTRL + Home Takes you to the top of your worksheet, 

usually cell A1. 

CTRL + End Take you to the end of your worksheet. 

PgUp (Page Up) and PgDn (Page 

Down) 

Takes you down or up several rows 

(screen pages) at each press of the key. 

CTRL + PgUp (Page Up) and 

CTRL+PgDn (Page Down) 

Scrolls through your worksheets or tabs.  

CTRL+PgUp Scrolls to the Left for you 

and CTRL+PgDn scrolls to the Right. 

CTRL + Shift + Down/Up Arrow Selects an entire column of 

data/information based on the cell that is 

selected. 

CTL + Shift + Left/Right Arrow Selects an entire row of data/information 

based on the cell that is selected. 

CTL + Shift + Home Selects from your active/selected cell to 

the top of your worksheet.  

CTL + Shift + End Selects from your active/selected cell to 

the bottom of your worksheet. 

 

 Write your notes here:_________________________________________________________ 

________________________________________________________________________ 
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Forming our Formulas  
 

Excel is Excel because of the powerful Formulas and Functions that the application uses or 

that you may produce.  Excel is “Excel-lent” at providing very complex and very simple built-in 

functions for you to use or you may create your own formulas.  Now, we need to learn how to 

“form” our own formulas. 

In the beginning is the cell.  As introduced at the start of this course, a cell is the intersection of a 

column and row, for example cell A1 is the intersection of Column A and Row 1.  Generally, A1 

is your “home” cell.  If you are in another section of Excel and wish to return to the beginning of 

the worksheet press the CTRL key and the Home key simultaneously.  We have entered text and 

numbers in cells and have formatted them.  Now, we will insert formulas in cells and use the 

cells in calculations. 

Formulas and functions in cells begin with the equal (=) sign.  A formula in a cell maybe =2+2 

or =(8*2)+10.  However, in Excel rarely will you use a specific number in a formula.  You will 

use various cell references for your formula to get the numeric value.  

Formulas in Excel follow the order of algebraic standards and the order of operations: 

✓ Items in parentheses are calculated first and work left to right, 

✓ Exponents are calculated next, 

✓ Multiplication and Division numbers/cells are then calculated, 

✓ Finally, Addition and subtraction items are calculated. 

Excel uses common Mathematical operators.  The mathematical operators are: 

Mathematical Operators  
Addition + 

Subtraction - 

Multiplication * 

Division / 

Exponents ^ 

 

 



Page 8 Excelling at Excel: Advanced Level 3  Greg Creech 
  www.gregcreech.com 

Thank you for Learning!  Techedutainment Services, Inc.  Greg Creech © 2018 
No Duplication Permitted  404-403-5391 

Symbols in Formulas  and Functions 

Below is a table of symbols and what they mean in formulas and functions.  This will help 

explain and use the syntax that Excel needs in order to work properly for your formulas and 

functions. 

Symbol What it means 
: (A Colon, such as A5:G5) 
=Sum(A5:G5) 

Think the word “Through” or a range of  
contiguous cells, so the sample at left 
would be “A5 Through G5”. 

, (A Comma, such as A5, C10, D12) 
=Average(A5, C10, D12) 

Think the word “And” or specific cells 
that are not contiguous, so at left would 
be “A5 and C10 and D12”. 

() Parenthesis – Cells used in the 
function or you may see a function 
without cells but have the () which is 
needed for the function to work, such as 
=TODAY() – which will put the date on 
the computer in your work sheet and 
update the date automatically for you. 

Specifies the cells or range of cells 
needed for the Function or to separate 
items that need to be calculated in a 
specific order for your formula. All 
functions must have parentheses, even 
with no cell reference. 

! (An Exclamation Point, 
=SUM(January:December!B5) 
This is a 3D reference. 

Think the word Join, The Exclamation 
points joins or connects different 
workbooks, worksheets, and cells in 
Functions and Formulas. 

= Equal Sign, =A5 + A6+B10 
=Count(A5:G5) 

Think “Excel I’m, giving you a formula or 
function.”  All Formulas and Functions 
must begin with an equal sign =. 

$ (A Dollar Sign, such as $B$5) 
Absolute and Mixed referencing. 
=$B5*$I$5. 

Think the word “Only”. Only use this cell 
in a calculation even if the cell’s formula 
is copied to other cells, the cell reference 
will not change.  This is the Absolute 
Reference symbol. 
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Cell Referencing and Addressing 

Aside from entering numbers for calculations, the primary power of Excel is Cell addressing and 

references:  Cells have various types of addresses and references.  I explain them below and 

demonstrate them in the coming pages.  We will use these types of cell references throughout the 

course.  As we build various types of formulas, we will refer back to this section. 

Relative Address 

Relative Address: A relative address changes the address of the cell relative to its location.  If 

you enter a formula calculating cell B3 as follows =B1+B2 then copy the cell to C3 the formula 

changes based upon the relative address to =C1+C2.  You may quickly and easily copy 

formulas; we discussed this in our previous section Excel F2 – Fills and will use this in the 

upcoming exercises. 

Absolute Address 

Absolute Address: An absolute address of a cell does not change.  The absolute address symbol 

is the dollar sign ($).  If you enter a formula in B3 as =$B$1+B2 and then copy the formula to 

C3 the formula becomes =$B$1+C2.  The absolute address allows you to specify your 

calculation using a specific cell for all calculations.  As an example, if you want your expense 

items to increase by 3%, you would place 3% in a cell and reference this cell in your expense 

calculations using the $ symbol.  When you see a $ in a formula, function, or cell reference think 

the word “only”, such as if you see $A$1 think “only use Cell A1 – do not change this reference 

even if I copy it.” We will use this for our forecast, VLOOKUP, and other functions/formulas 

later 

Mixed Address 

Mixed Address:  This uses both relative and absolute addresses.  If you want the reference in a 

particular column or row not to change and another reference in a particular column or row to 

change, you would use  =$A1+B1 in cell C1 (Column A would be used however the row would 

change).  If you copy this cell to C2, the formula becomes =$A2+B2. 

3-D References 

3-D References: This uses cells in other worksheets.  The exclamation point (!) separates the 

worksheet name and actual cell.  If you want to add January rent and February rent for a total in 
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March, you would enter a formula in the March worksheet as follows:  

=January!B5+February!B5 (Note that your formula bar will guide you through the calculation 

and illustrate your position in accomplishing the formula or function.) We will use this for our 

summary worksheet later. 
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Summary Worksheets  

A worksheet that summarizes data across multiple worksheets is a real time saver.  We will 

create an annual worksheet based upon our monthly worksheets.  However, you could create 

quarterly worksheets and then base an annual worksheet on the quarterly sheets.  There are many 

applications and efficiencies for using Summary worksheets. 

Through our Annual worksheet we will use different kind of formulas and functions. First, the 

formulas and the Sum functions we utilized in our monthly worksheets are relative reference 

cells.  Now, we will examine the 3-D reference and finally in our next worksheet we will use 

Absolute references and Mixed references.  Our next worksheet will be a forecast worksheet for 

future budgets and expenses based upon a percentage of the current budget and expenses; an 

absolute reference provides the ease of changing a percentage and associated figures. 

 

Here are the steps for creating our Annual Worksheet: 

 

1. First, let’s copy the December worksheet and rename it to Annual in 

our Budget.xslx, click the December worksheet, 

2. With the December worksheet selected, press your CTRL (Control) 

key and keep it pressed, 

3. Click the December worksheet (your cursor changes with a sheet of 

paper and a plus (+) sign) and drag the December worksheet over 

next to Sheet 2 or at the end of your worksheets.  An arrow will 

display where your worksheet will be inserted. 

4. When your worksheet is in position between December and Sheet 2, 

release your mouse button, 

5. Release your CTRL key. 

6. You have a new worksheet named December (2), 

7. Double click it to change the name to Annual. 

8. After renaming your worksheet to Annual, Click cell A2 and change 

the heading to Annual Budget and Expenses. 

Your Annual worksheet is only a copy of December; time to change that!  Using this Annual 

worksheet, we will create a function that adds all of the worksheets together using the SUM 

function and 3-D reference. 
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1. In the Annual worksheet, Click in cell B5, 

2. Click the AutoSum button.  

3. The Sum function appears in your formula bar as: =SUM(). (Since 

there are no numbers above this cell or to the left, Excel did not 

assume a range of cells.)  

4. Click the January sheet. 

5. PRESS YOUR SHIFT KEY AND KEEP IT PRESSED (This can be the 

tricky part). 

6. Using the Navigation Buttons, scroll until you see December (If 

the December worksheet is in your view just click it with your shift 

button pressed.). 

7. Click the December sheet. 

8. RELEASE YOUR SHIFT KEY. This selects your sheets contiguously.   

9. Click Cell B5. 

10. Press your Enter Key. 

11. Your completed 

formula bar for cell B5 

appears here. 

 

Like a math wizard Excel calculates the 12 months of your Lease budget!  This type of 

calculation is termed a 3-D reference and calculation since we use other worksheets to 

compile the equation.  The exclamation point or bang symbol (!) is our separator.  You can 

link entirely different Excel files on another computer or server using the exclamation point 

as a file, worksheet, etc separator.  

 

Do we have to repeat these steps for every cell?  Nope!  Remember our buddy Fill Handle?  

Time to use Dr. Fill. 

1. In your Annual Worksheet,  

2. Click Cell B5 (with our calculation =SUM(January:December!B5)),  
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3. Position your cursor over the lower 

right corner and when you see the 

plus sign (+ - Fill Handle), click and 

drag horizontally to Cell D5.  Your 

formula copies to these cells. 

4. With Cells B5 through D5 selected for you, 

position your cursor over Cell 

D5’s tiny, black box in the right 

lower corner of its border and 

with the Fill Handle, Double Click 

the fill handle and Dr. Fill 

completes your formula through 

row 15. 

5. You may need to use the Fill 

Option box and choose Fill 

Without Formatting in case Fill 

creates or deletes your borders 

or other formats that you wish to 

keep.  This is displayed for you 

here. 

Wow!  Fill has done the job of copying 

all of the formulas for you!! 

 

We have our annual budget, expenses, totals, and differences. 

For practice, go into any of your worksheets and change a number.  For example, in April change 

your Lease Budget and Expense to $0.  Notice that your April worksheet reflects the change.  

Click the Annual tab and notice the change in figures for the Lease cells.  Changing the amounts 

is easy and will calculate correctly.  Change the position of the cells or inserting rows will spell 

disaster for you!  Avoid inserting cells and rows.  As I related, the worksheets must be exact.  

The numbers don’t have to be the same, but the position of cells, rows and columns is very 

important because we are using relative referencing to accomplish our annual summation.  We 

will add a row to all of our worksheets and a function on all of them at once using the Group 

feature, again. 

+ 
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Global Worksheet Change 

After you complete the Greatest Worksheet and Workbook in the World, someone will say:  

“That’s nice, BUT you forgot to add an item.”  Initially you will want to shoot the person, but 

it’s not worth being arrested and Excel provides a way to update all worksheets at once through 

using the Grouping feature we have previously employed in our other exercises. 

 

If you want to add, delete, or change all of your worksheets at one time, you may make this type 

of global change by selecting them all and making your change.  With thirteen worksheets 

available we will use our navigation buttons to assist in selecting all of the sheets.  As we have 

previously learned and used, pictured below are the Navigation buttons to use to select or to 

move to your various worksheets; these buttons are located in lower left section of your screen 

adjacent to your worksheet tabs.  Note:  These buttons do not function until you have so many 

sheets that you are no longer able to click to select or open a worksheet. 

 

Navigation Buttons: 

 The navigation buttons at the lower left of your status bar allow you to scroll 

through your worksheets to the left or right.  Right Clicking the navigation 

buttons retrieves a menu of all of your worksheet names for you to click to 

move to that worksheet or tab. 

 Write your notes here:_________________________________________________________ 

 

________________________________________________________________________ 
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Let’s add a new line item by inserting a row and update the sheets and calculations; we will 

also add a function to the sheets.  Here are the steps to add a row to all worksheets: 

 

1. First, have January worksheet visible, 

2. Click the January worksheet,  

3. Scroll until you see the Annual Worksheet, 

4. Press your shift key and keep it pressed, 

5. Click the Annual worksheet; January through Annual worksheets will 

turn gradient and are selected or grouped for you, 

6. Right Click on Row 11 (Click the number 11 for the row otherwise 

known as the Row Header). 

 An Important Gotcha!  Please ensure that you are in the range of your cells when 

inserting columns and rows – avoid inserting rows or columns at the beginning or the 

end of your information.  Excel may not update calculations for you to include the 

new rows or columns. We want our Total, Average, and Count functions to update 

automatically and change the range for us that is why we inserted the row within our 

list.  

1. After right clicking row header 11, the shortcut 

menu appears, 

2. Click Insert, 

3. A new row inserts for you,  

4. In Cell A11 type the word Travel, 

5. In Cell B11 type 250 for the Budget, 

6. In Cell C11 type 250 for the Expense, 

7. Copy the Formula in Cell D10 to D11 using your 

Fill Handle. 

 Write your notes here:_____________________________ 
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Here are the steps to globally add a date on all of the worksheets. 

1. With your sheets selected, 

2. Click Cell A1 in any worksheet and type =TODAY(), 

3. =TODAY() is a function that will display the 

current system date on your computer and is used 

in calculations as well.  We will use this later to 

perform age  and service calculations.  

4. After inserting the Today function, select the cell and using your 

Number Format box and the cascading menu change your format to 

Long Date and format the date as you like, such as bold, font, color, 

etc. 

5. Right click a worksheet tab and click Ungroup Sheets, 

6. Click a worksheet tab to see the date.  Click several worksheet tabs to 

view the date change of your worksheets. 

 

All looks great, except go to the Annual Worksheet.  Oops! The Travel item doesn’t have the 

calculations for all of the worksheets; the cell contains the number 250 that we typed in.  Let’s 

change this. The only assumption Excel will make in changing all of worksheets is your 

formatting.  Generally, Excel doesn’t assume the function or formulas when you add rows or 

columns. 

1. In your Annual worksheet, 

2. Select Cells B10 through D10, 

3. Using your Fill handle, click and drag to 

row 11 

4. After releasing your mouse button the 

figures should reflect $3000 for Budget and 

Expense with a difference of $0. 

I use this ability to update all of my worksheets at once a lot and hope you’ll find this to be a real 

time saver. 

 

 Write your notes here:__________________________________________________________ 

  

+ 
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Forecast Worksheet and Absolute 
Reference 

Now that we have our annual budget and expenses, let’s forecast our Budget and Expenses.  First 

we will copy our Annual worksheet and then add Absolute Reference calculations to 

automatically increase our budget and expense by a certain percentage.  We could accomplish 

this task without Absolute reference; however, we would have to continue to change our 

formulas and copy them throughout our worksheet.  With Absolute Reference we need only 

make one change in one cell to impact figures throughout the worksheet.  Using Absolute 

Reference prevents errors, is more efficient, and easier to manage. We use Absolute Reference 

to provide a constant number in our formulas and functions and using a cell reference for a 

consistent number is easier than editing a formula or function and changing the number.  

 

Here are the steps for creating a forecast worksheet that will include our current year, too. 

1. Copy the Annual worksheet using our right click, shortcut menu, and 

the Move or Copy function OR use the CTRL and Click and Drag 

method. 

2. With your Annual worksheet copied, rename the Annual (2) 

worksheet to Forecast. 

3. Change the title of your worksheet (Cell A2) to: Forecast Budget and 

Expenses. 

4. Next, let’s Merge and Center a new area that will encompass new 

columns of data for our forecast. 

5. Select cells A2 through G2, 

6. Click the Merge and Center command button once to turn off the 

Merge and Center, 

7. Click the Merge and Center command button again to turn on the 

Merge and Center formatting on the new area (A2 through G2). 

 

 Write your notes here:_________________________________________________________ 

________________________________________________________________________ 

________________________________________________________________________ 
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We want to keep the information in tact; however, we need to make a copy of the area of our 

budget, expenses, differences, and totals. 

Let’s learn a new way to select an area of your worksheet. 

1. Click in your Name Box and type B4:D16.  The Name box is 

located to the left of your Formula Bar and directly above Row 

1 and Column A.  My Name Box is pictured here.  

2. After typing B4:D16 in your Name Box, Press Enter (You 

must press enter in order for Excel to execute your selection.) 

Your cells select for you without clicking and dragging.  Excellent 

keyboardists prefer this method; while excellent Mouse users like the click 

and drag.  People who are excellent at both, the Keyboard and Mouse, like 

the Shift and Click method of selecting areas of your worksheet. 

3. Right click in the selected area and from the shortcut menu Click 

Copy  or you may press CTRL + C or use the Copy command button on 

the Home tab.  A Scrolling Marquee (some call it “marching ants” or 

“squikkly thingies”) appears around the selected cells. 

4. Right Click in Cell E4 and from the shortcut menu click Paste or you 

may press CTRL + V or use the Paste command button on the Home 

tab. We will learn more about Copy and Paste in the next section of 

this manual. 

5. Press the Esc key on your keyboard and the scrolling marquee stops. 

So we have a duplicate area. 

 

Our area is copied and 0’s or dashes appear below the headers.  Since the 

cells we  copied were relative reference, our copied area needs to change. 

Click in Cell E5.  The formula bar 

displays, 

=SUM(January:December!E5). 

 

We have a duplicate of our information using the wrong cell reference.   

 

Now, let’s forecast our budget and expenses by using Mixed and Absolute References. 
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 An Absolute Reference is a reference that will use only a specific cell, specific row, or specific 

column in its calculation or reference; this is pictured in the formula bar here as $I$1 which 

signifies ONLY USE this Cell, even when the cell is copied to other cells – do not change this 

cell reference.  A dollar sign ($) 

signifies to Excel to use only a 

certain cell, row, or column.  A 

Mixed Reference uses both a relative 

reference (a row or column can 

change relative to position) and an 

absolute reference (a specific row or 

column cannot change in relation to 

position of the calculation)  Pictured above is the Mixed cell reference of $B5 which will not 

change the column (since I always want Column B to be budget); however, the row will change.  

I will want the row reference to change to other items. 

 

We will change our Budget, Expenses, and Difference calculations to reflect a Mixed 

Reference.  Here’s how we will change the formula.  We will first designate two cells to be our 

percentage increase (or decrease) for the Budget Increase and our Expense Increase. 

1. In cell H1 type Budget Increase. 

2. In Cell I1 type 1.05 and press enter. 

3. Click to select H1 again and click the format percent (%) Command 

Button on the Home Tab, 

4. Next, in cell H2 type Expense Increase. 

5. In Cell I2 type 1.03 and press enter. 

6. Then, click to re-select I2 and click the % 

icon. 

We have our two cells: I1 for Budget Increase and I2 for Expense increase. 

Format your cells as you wish. 

Time to use these cells in our Absolute Formula. 

1. Click in Cell E5, 
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2. Highlight the entire =SUM formula on the Formula Bar, and type 

=$B5*I1.  You may click the cells and Excel will provide the cell 

reference in your formula, but you’ll have to add the $ before the B. 

3. Press enter. 

4. Using your Fill Handle copy the formula down to E10. 

What Happened?!  What’s Wrong with the calculation?  You may receive 

Value errors, 0’s, and incorrect figures or calculations.  Why? 

Click Cell E6 and notice that the Cell referenced is cell =$B6*I2. Cell I2 is not 

what we want. Click cells E7, E8, etc. notice that they are not using cell I1 as 

we need.  This is still using relative reference. Time for our absolute 

reference!   

 

Absolute reference will signify to Excel to ONLY use Cell H1 in the calculation. 

1. Click in Cell E5. 

2. Click in I1 on the Formula (VERY IMPORTANT, make sure you have 

clicked in I1 on the Formula bar, so Excel will know which cell to 

apply the mixed/absolute reference). 

 Hot Tip! Using the FN4 – Function 4 key to toggle through 

your references. While you may type the $ for Absolute and 

Mixed references, using the FN4 key on your keyboard will 

toggle through all of your references for you.  Click the cell 

reference using the formula bar or the cell with your 

reference, then continue to press your F4 key to toggle 

through all of your references, such $B5 or $I$1.  

3. On your keyboard Press the FN4 key(s), some keyboards require you 

to press an FN key and 

the F4 key together.  In 

Excel when you are 

clicked in a cell 

reference, the FN4 

(Function 4) key is a 

shortcut to use for cell 

referencing.  Your 
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formula will change to $I$1 continue to press FN4 to notice how it 

will change the cell reference formula.  Stop pressing FN4 when your 

formula reads - $I$1. 

4. =$B5*$I$1 is our completed formula. Press Enter to have Excel 

accept the Formula.  

The above formula tells Excel Only to Use Column B and then to 

only multiply the figure by cell I1. 

1. Using the Fill Handle copy the formula to Cell 

E16. 

2. After you Fill down, click on the drop-down arrow 

for your Auto Fill Options icon and click Fill 

without Formatting. 

Now, our calculations and data are correct! Let’s test this out. 

Click in Cell I1 and type 1.02 and press enter. 

Notice that Excel automatically changes your Budget figures to accept 

this new figure.  Changing one cell impacts many other cells; this is the time 

savings of using Absolute Reference.  We can play all sort of “what if” games with our figures 

without any trouble of having to copy and paste our updated percentages. 

Enter 1.05 in Cell I1. 

We need to build a forecast for our Expenses. 

1. In Cell F5, Edit the Formula on the Formula bar to read $C5*$I$2 – 

remember you may type in the 

formula or use your click and F4 

methods of having Excel enter 

the dollar signs ($) for you. 

2. Once your cell reflects the updated expense forecast, use the Fill 

Handle to copy the formula to Cell F16. 

Now for Formatting practice, on your own accomplish the following using 

previous sections of this manual to help you: 

3. Create a heading in Cells B3 through D3 for the Current Year and E3 

through G3 for the Next Year, 
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4. Use your Merge and Center command button,  and Use Fills and 

Borders around the areas to accentuate these different budget and 

expense years, 

5. Change your font and create interesting formats for these areas, 

6. Next, you may need to change your Difference formula in Cell G5, 

7. Change Cell G5 to read =E5-F5, 

8. Fill this formula down to G16, 

9. Using the Auto Fill Option Icon, Fill Without Formatting. 

 

We have our Annual Budget and Expenses and a Forecast for Next year complete!  Now let’s 

learn some of Excel’s other neat features, such as Conditional Formatting, Paste Special, and 

Paste Preview. 

 

 Write your notes here:_________________________________________________________ 

________________________________________________________________________ 

________________________________________________________________________ 

  



Greg Creech Excelling at Excel: Advanced Level 3  Page 23 

www.gregcreech.com 

Greg Creech © 2018 Techedutainment Services, Inc.  Thank you for Learning! 

404-299-1706  No Duplication Permitted 

Worksheet and Workbook Linkage  
We created a 3-D reference that linked our worksheets using the SUM function. Excel allows 

you to retrieve data from any worksheet or workbook that you have access. If you can open the 

workbook from which you want your data, creating linkages are easy. As with 

formulas and functions, linking begins with an equal sign. After the equal 

sign, simply click the worksheet and the cell you wish to link. Excel creates 

the linkage and includes the exclamation point for you.  

 

Let’s create a worksheet linkage first and then we will link to a workbook. 

1. In your Track workbook, insert a new worksheet, and rename it 

Linkage. 

2. In cell A1, type January Revenue, 

3. In cell A2, type February Revenue, 

4. In cell A3, type March Revenue, 

5. In cell B1, type an equal sign, 

6. Next, click the Jan worksheet and then click cell B5, press enter. 

7. Excel inserts the January revenue figure. 

8. Next, repeat this step for cells B2 and B3 

using Feb and Mar worksheets. My linkage 

formulas appear here with my total using 

the SUM function. 

9. Finally, in the Jan worksheet add numbers 

to a customer to increase the revenue. When you navigate to your 

Linkage worksheet notice your cell B1 updates for you. 

 

 A Hot Tip! Linking ensures that when you change your 

information in one worksheet, the linked worksheet 

automatically updates for you.   

 

Workbook linkages work the same as a worksheet linkage, except you navigate to an open 

workbook and then click the worksheet and cell(s) that you wish. In this exercise, we will link 

an area of a worksheet, not just one cell. 

 

1. Create a new blank workbook and have your Budget file open. 

2. In your new workbook, click in cell A1 enter an equal sign (=), 

3. Navigate to your open Budget file and click cell A4. 
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4. Now, Excel’s formula bar displays =[Budget.xlsx]January!$A$4. 

Notice Excel uses Absolute Reference for these cells with the $ signs. We 

want to link an area of this worksheet from A4 to D17 without Absolute 

Reference; therefore, we will need to turn the cell reference to a Relative 

Reference without the $ signs. 

1. In your formula bar, click in the cell $A$4 and press the Function 4 key 

until the reference is A4 or delete the $ signs from the cell reference. 

Press enter. Excel returns to your blank workbook with Items in cell 

A1. 

2. In the blank workbook, your formula bar should display 

=[Budget.xlsx]January!A4. 

3. Now, using AutoFill, Fill to D1. Excel inserts the column headers 

Budget, Expense, and Difference from the January worksheet. 

4. Finally, select the cells A1 through D1. Again, using your AutoFill 

handle fill down to row 14. 

5. Viola! Excel links these cells from the January worksheet.  

Now, when you make a change to these cells in the January worksheet, 

Excel updates your cells for you. Try it, in your Budget’s January 

worksheet change cell A5 from $1200 to $1100. Next, navigate to your 

Linkages workbook and notice cell B5 updates automatically. 

6. Save your workbook as Linkages. 

 

A few important notes about linking: 

✓ Excel does not link the formatting, only the data. 

✓ Do not move or delete the linked workbook, Excel can’t update and the linkages no 

longer works. 

✓ To remove a linkage, simply delete the contents of the cell containing the links. 

✓ Your formula bar may display the path to your file. This path to your linked file can 

be quite complicated and lengthy depending upon where you store the file, such as 

remote servers, including the cloud. My linked path for cell B5 displays here. 

 

  



Greg Creech Excelling at Excel: Advanced Level 3  Page 25 

www.gregcreech.com 

Greg Creech © 2018 Techedutainment Services, Inc.  Thank you for Learning! 

404-299-1706  No Duplication Permitted 

 

With linked data, the Data Tab has an important command for you to use 

to edit, remove, and perform other actions with your linkages. The Edit 

Links command button displays here and opens the dialogue box below 

for you to manage your linkages. I usually have my Update set to 

Automatic, which is the default; UNLESS, the data linkage covers 

multiple workbooks from several sources, and links large areas. As it 

updates, Excel may slow to a crawl; you may want to use the Manual 

option. With Manual selected, you will want to use the Update Values 

button to refresh your workbook with the latest information.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When you open a file that has linkages, Excel may prompt you if you want to update the linkages 

or not. Your Startup Prompt button allows you the 

options displayed at left.  With the default (Let users 

choose to display the alert or not), Excel provides the 

prompt dialogue box below. 

,  
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Conditional Formatting  

Excel has a feature that allows you to have cells formatted in a particular manner when a value 

or range of values is present.  This feature is aptly called Conditional Formatting.  I have used 

Conditional Formatting to color code cells based on a value for several companies.  Here are a 

few example of how I have used Conditional Formatting to help my clients. 

 

✓ Color Code cells based on ZIP codes for an Insurance company that needed to have high 

accident ZIP codes in one color, medium accident zone ZIP Codes in another color and 

finally low accident zones ZIP codes in another color. 

✓ A telecommunications company used color coding for date ranges to alert them when 

orders were due and overdue.  

✓ As a Human Resources Manager, I used Conditional Formatting for attainment 

percentages and to color code highly, medium, and lowly ranked sales people.  

 

You will want the skill and knowledge for creating and managing your own rules, so we will do 

that first. For our example, we will want to color code our difference Columns in order to take 

money from one category that is under budget and give money to other items that are over 

budget.  We will color code our Difference columns so at a glance we will know which items we 

can take money from and those that we need to leave as is. Then, we’ll use some of Conditional 

Formatting’s built in functionality for percentages and number values. 

 

Custom Conditional Formatting  
Here are the steps to have our numbers in the Differences columns formatted based upon a 

value in the cell. 

1. Have your Budget Workbook open, 

2. Click on the Forecast tab, 

3. Select Cell D5 through D14 through click and drag. 

4. Press your CTRL key and Keep it pressed, 

5. Click and drag Cell G5 through G14, 

6. Release your mouse button and release the CTRL key. 
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7. Our two areas are selected that we want to use Conditional 

Formatting. 

8. On the Home Tab, click the Conditional Formatting 

command button,  

9. From the cascading menu, click New Rule . . . 

10. In the Select a Rule Type, I am choosing only cells that 

contain.  

11. Using the Format only cells with boxes, I keep Cell Value 

and change the middle box to greater than and then type 

300 (I want to give the dollar amount above three hundred 

special formatting). 

12. Next, click the Format button, 

and the familiar Format Cells 

dialogue box opens; however, 

not all items are available but 

you may change your Font Style 

and Color as well as provide a 

border and fill color and pattern. 

13. As pictured at right, we will 

change our dialogue box to 

reflect the values and range of 

values with specific colors. 

14. Change your font to bold and change 

the font color for values that are 

greater than 300. 

15. Click the Fill tab and give your cell a 

fill color – I chose light green. 

16. Click OK. Click OK, again, at the 

Greater Than box. 

17. Your formatting changes for cells 

greater than 300.  



Page 28 Excelling at Excel: Advanced Level 3  Greg Creech 
  www.gregcreech.com 

Thank you for Learning!  Techedutainment Services, Inc.  Greg Creech © 2018 
No Duplication Permitted  404-403-5391 

Let’s add another rule and learn to edit and add new rules. 

1. With your area D5 through D14 and G5 through G14 still selected in 

the Budget workbook and Forecast Tab,  

2. Click the Conditional Formatting Command Button, Click the Manage 

Rules item at the bottom of the menu. 

You may create, edit, and delete rules from this location and also change 

the area you want to set rules for 

using the Show Formatting rules for: 

area.  

1. Click the New Rule. . . button. 

2. At the New Formatting Rule Pane, 

choose the Format only cells that 

contain item. 

3. In the Edit the Rule Description: 

area change your Cell Value to 

between with 0 and 300 (we 

want our numbers 0 through 

300 with a special formatting). 

4. Click the Format button, 

5. In the Format Cells dialogue  

box, choose Bold and a color 

and on the Fill tab choose a fill 

color, if you like. 

6. Click OK. 

7. At the New Formatting Rule 

pane, Click OK. 

8. At the Manage Rules pane, click the Apply button and Excel displays 

your formatting for numbers between 0 and 300.  
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1. Using your Manage Rules pane, 

Click New rule, 

2. Now, using these steps as a 

guide create your own rule and 

formatting for values less than 0 

(negative numbers) for cells D5 

through D14 and G5 through 

G14.  

3. My completed Conditional 

Formatting Rules Manager pane 

appears below with the rules and formatting applied to the selected 

areas of my worksheet. 

 

  Hot Tip: You will want to create a legend or insert 
comments about the formatted cells. The reasons for the 
colors may not be obvious and the user may not know to use 
the Conditional Formatting Rules Manager.    
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Automatic Conditional Formatting  

Excel has many terrific built in Conditional Formats that provides magic for your numbers and 

percentages as well as text and dates.  Excel can rank your values in neat and easy ways.  We’ll 

look at these ways of using Excel’s Automatic Conditional Formatting.   

1. First, open a file entitled Database Functionality, Click the Conditional 

Format Personnel tab, 

2. Select the Percent column Cells M2 through M48 or select the entire 

Percent column by clicking the Column Header M, 

3. Click the Conditional Formatting button and from the 

menu look at the various styles.   I am choosing one of 

the Color Scales. 

 A Hot Tip!  You can apply more than one of 
the built in formatting rules to your cells.   

4. Next, with my Column M (Percent) still selected, I 

use Conditional Formatting to add Icon sets to my 

numbers. 

5. For practice select the Bonus cells 

of N2 through N48 (or Click column 

header N to select the entire column) 

and using the Conditional Formatting 

button and menu select a format for 

your bonus ranges. Save your 

workbook. 

 

On your own, use Conditional 

Formatting for the Age column.   
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If you want to know the rules for the 

formatting that the built-in conditional 

formatting employs, you will need to use the 

Manage Rules Pane and the Edit rules item. 

I am displaying the rules for my color scales 

here.  

 

 

Conditional Formatting can format your information 

based on the top or bottom items and above or below 

averages and other types of numerical data for you. 

Practice using difference rules for your numbers, text, and dates.  You may use your Quick 

Analysis Menu to add Conditional Formatting, too.  

 

 Write your notes here:_________________________________________________________ 

________________________________________________________________________ 

________________________________________________________________________ 
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Name Box and Name Manager  

The Name Box, located to the Left of the Formula Bar, is a way 

to give a cell or a range of cells an English name.  This will 

allow you to use the English Name in calculations or to quickly 

go to this cell using the Name Box’s drop-down arrow.  We will 

use the Name Box to name cells, an area of our worksheet, and 

to use in calculations. 

 

 An Important Gotcha! You cannot use spaces in Names 

you enter in the Name Box; Excel gives you an error 

message, if you put a space in 

a Name.  Also, press the 

Enter Key after you type in a 

name; otherwise, the Name 

Box will not save your text. 

So, no spaces in Names and 

press the Enter Key after you 

type a Name. You may use an Underscore character for a space if you like.    

 

A Hot Tip!  Here five reasons we will learn to love the Name Box and Name 

Manager: 

1. Makes a cell reference absolute (you can use a name rather than the dollar 

signs - $A$1), 

2. Navigation, 

3. Selection, 

4. Used in formulas and functions, 

5. Store Values.    

 

Let’s use the Name box to “name” our 7.75%, 360, and $-85,000 

Here are the steps for adding a Name to a Cell. 

1. Click cell C2 with our Percentage, 

2. Click in the Name Box, and type Rate and press enter, 

3. Click cell C3 with our figure of 360, 

4. Click in the Name Box, and type Months and press enter,  

Name Box 
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5. Click cell C4 with our figure $(85,000.00), 

6. Click in the Name Box, and type LoanAmount and press enter,  

7. Click cell C6 which will contain our Payment Function, 

8. Click in the Name Box, and type Payment and press enter, 

9. Click and drag to select cells B2 through C6, 

10. Click in the Name Box, and type LoanInfo, and press enter. 

Now, let’s use the Name box for navigation and selection. 

Go to another worksheet, and click the down arrow on the Name 

Box and click a name to quickly go to that worksheet and cell.   

 

 Hot Tip! The Name box helps in maneuvering and in 

navigating to different areas of your workbook quick and 

easy. I once had all of the total of a worksheet on row 57,569 

I named that row TheBottomLine and any time I needed to 

quickly go there I could using the Name Box no matter what 

other worksheet I was.  

1. In an empty cell type =LoanAmountt+5000. 

2. The result will be –80000 (Remember our loan is a negative number!) 

3. Clear the cell. 

The Names take on the value of the cells and update as you change the figures in the cells. 

 

 Write your notes here:_________________________________________________________ 

 

________________________________________________________________________ 
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Na me Ma nag er  

Excel has a great feature to help you with Names – The Name 

Manager. This will allow you to edit your names, create new 

names, delete names, and change the cell reference or value.  

The Name Manager is pictured here and is part of the 

Formulas Tab and the Defined Names Group.  

Notice I have LoanAmount 

selected, so my buttons at top 

are all active. You can Edit and 

Delete Names and Cell 

References here and create new 

names for specific cell(s).  You 

can used the Refers to: section 

to type your cell references or 

you can use the Collapse button 

to click your cell references.  As 

I related earlier Names by 

nature are Absolute Reference 

and the Refers to Section with 

the =’Loan Calculator’!$C$4 

pictured at right demonstrates. 

Let’s add a new name to 

represent a constant value.  We’ll use .54 as if this were a percent or maybe mileage at cents 

per mile.   

1. In your Loan Calculator worksheet, click the 

Formulas Tab and click the Name Manager command 

button, 

2. Click the New Button in your Name Manager,  

3. For the Name enter: Mile, 

4. Keep the Scope at Workbook, although you can store 

names in specific worksheets, 

5. Provide an appropriate comment, 
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6. In the Refers to section enter =.542 (our constant value), 

7. Click OK, 

8. Click the Close button in the Name Manager window, 

9. Click in Sheet 2 and click in any cell and enter the formula 

=100*Mile. Notice as you type Mile that Excel provides 

the AutoComplete feature for you to double click the Mile 

label to insert the name into your formula.  

10. Press enter – Excels provides the calculation.  

In reality, our constant numbers are not so constant and values, like mileage, change. Let’s 

edit our name for a new value. 

1. Click your Name Manager button and select or highlight Mile, 

2. Click the Edit Button . . .  

3. Your Edit Name pane appears, in the refers to section change the value 

to =0.6, 

4. Click OK,  

5. Click close at the Name Manager pane. 

6. Your value for your name changes in the formula’s result. 

The Other command buttons on the Defined Names Group are 

good for creating and using names without the Name Manager. 

The Define Name button allows you to create new names by 

opening the New Name page for you and to apply names.  The 

Use in Formula button lists your names for you to use in a 

formula, if you click a name Excel begins your formula in the 

formula with an equal sign and your name.   

 

We could have used the Create Names From Selection command button, too.  

This allows you to select a Range for example B2: C6 in our Loan Calculator 

worksheet and name the cells base on adjacent cells. For example, this 

would automatically name cell C2 Rate based on cell B2. 
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Is it  Valid?  Data Validation  

Da ta  Va l ida t ion  O verv i ew  

Excel has a fantastic method for checking your data and restricting your input.  This feature 

entitled Data Validation ensures accuracy, ease of input, and flexibility in entering data.  I used 

this especially when I share workbooks in order to collect data from other people.  These people 

may not know how to use Excel or are uncomfortable in using the application; data validation 

makes input and using Excel easier for the novice Excel person.  Under the Data Tab, you will 

find Data Validation.  This has a three tab dialogue box for configuring the data types and 

ranges allowed, an input message tab, and an error alert tab. 

We will use a worksheet and add validation to it.  First, let’s examine a worksheet that already 

contains validation rules to understand what we will be doing. 

Da ta  Va l ida t ion  Sa mple  

1. Open the Data Validation workbook, 

2. Click the Jan Data Validation Sample tab   This is similar to the 

worksheet we have previously used.  We will add data validation to 

certain areas of it.    

Let’s look at a Date Validation first. 

1. Click cell B8.  Notice the Input message displayed 

alerting you to enter a date between 01/01/2018 and 

01/31/2018, 

2. Enter 02/01/2018 or any date outside of the correct 

range, 

3. An error message activates – Notice how polite my 

message is! 

4. Click retry 

and correct 

your entry to 

01/14/2018. 
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Now, let’s look at a popular item in Excel and that is using a lookup list 

or drop-down menu to select information. 

1. Click cell C8,  

2. Notice the input message for the clients,  

3. Click the drop-down list and select a client from the 

list, 

4. Now, type your name in cell C8, 

5. Notice the Error message that displays; you may continue by clicking 

OK or pressing enter, 

6. Click OK.  

Excel allows you to 

continue unlike the 

previous error message 

and data validation rule. 

Excel’s Data Validation lets you create your own type of error message 

which we will accomplish in a moment. 

Finally, let’s look at a number validation example. 

1. In cell D8 type 12.  Notice that we have an input message box telling 

us to input our time; however, an error message box asking us to 

verify our input activates if we enter a number greater than 10. 

2. Click Yes to continue. 

That’s it!  Excel has guided us to correct input using data validation. 
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Time for us to create our own Data Validation. 

 

 Write your notes here:_________________________________________________________ 

 

________________________________________________________________________ 
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Da ta  Va l ida t ion :  You  go t  the  Power!  
We will add the data validation in the previous section to a file entitled DataValidation.xlsx. 

Date Validation and Required Information  
Here are the steps and screens for adding data validation for required information with a date 

range. 

1. Open the Data Validation workbook, 

2. Click the Jan tab, 

3. Select Column B; this is the column or cells we 

wish to place a condition on the input, 

4. On the Data Tab, click the Data Validation 

Button in the drop-down menu click Data 

Validation as displayed here. 

The Data Validation Dialogue box contains three tabs: 

✓ Settings: The actual data 

validation rules and 

guidelines, 

✓ Input Message: A 

message displayed in the 

cell with the rule to guide a user’s input, 

✓ Error Alert: An error message will appear if the user inputs incorrect 

data. The three types of Error Alerts are: 

o Information – Allows you to continue and you may enter 

incorrect information,  

o Warning – You must click Yes, No, or Cancel to accept the input,  

o Stop – Will allow a user to only input the required data. 
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1. In the Settings tab, click the Allow drop-

down box.  Notice all of the types of data 

that can have requirements. 

2. Using the screenshot, enter Date in the 

Allow box, 

3. Between in the Data box, 

4. And 01/01/2018 in the Start Date, 

5. And 01/31/2018 in the End Date. 

 

We only want January, 2018 orders input in this 

worksheet and cells. 

 

1. Click the Input Message tab: 

2. Ensure the Show Input message when 

cell is selected check box is checked, 

3. In the Title area, type Correct Date, 

4. In the Input message type the Input 

message as displayed here, 

5. This is to instruct and help the user in the 

required input. 

Now, if the person does not enter the correct 

information, we need a nice way to alert them. Time to 

create our Error Alert Message Box. 

1. Click the Error Alert tab, 

2. In the Style box drop-down list choose 

Stop,  

3. Type the Title of the Error Message 

WRONG DATE!, 

4. Finally, give an appropriate Error 

Message,  

5. Click OK. 

Let’s try out your rule. 
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1. Click an empty cell in your specified range.  Notice the Input Message 

box, 

2. Type 12/31/18, 

3. The Stop Error Alert Message Box activates.  Click Retry and Enter 

01/01/2018. 

 

There is our first rule! 

 

Next, we will provide a List from which a user may choose a client name rather 

than typing in a client name.  The next data validation will provide a list of our 

popular clients which we can choose and if not a Warning Error Alert activates. 

You may type in the list as you create the rule or you may use an existing list.  If 

you create a List rule and use an area of your worksheet (or another worksheet as 

we are accomplishing) as your list (which is a good idea), the data is easier than 

updating the Validation Rule dialogue box and panes. You may type in the 

worksheet and the area that contains your list rather than use a list in your Source 

box. I always hide my list whether my list is a worksheet (I hide the worksheet) or 

an area of my worksheet with the validation rule (hide column). We will use a list 

that exists on the worksheet Client List.  The Client List tab appears at right. I have 

sorted my client list and named this area ClientList using my Name box.  

1. In the JAN Worksheet,  

2. Select column C. 

3. On the Data Tab, click Data Validation and 

from the menu click Data Validation.  

4. The Data Validation Dialogue box opens. 

5. In the Settings Tab, choose List for the Allow 

area, 

6. Next, in the Source area, click the Client List 

worksheet tab and your dialogue box changes 

as displayed above. Click and drag your cells 

A1 through A25 – the client list of names. I named this area ClientList. 
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7. Next, click the Input Message tab and 

enter a title and the Input Message, 

 

 

 

 

 

 

 

 

8. Finally, click the Error Alert tab, and use 

an information style alert and type the Error 

Alert information as you wish, 

9. Click OK. 

Time to try out our new rule. 

1. In your worksheet, click an empty client 

cell and notice the drop-down box.  Click the 

drop-down box to view the customer names. 

2. Type your name, 

3. An error message box activates, 

4. Click OK. Excel allows your name in the 

cell. 

  Note:  You can add, change, or delete items on your list by editing your 

Client List.    

  



Greg Creech Excelling at Excel: Advanced Level 3  Page 43 

www.gregcreech.com 

Greg Creech © 2018 Techedutainment Services, Inc.  Thank you for Learning! 

404-299-1706  No Duplication Permitted 

I want to add a new client, Geeks R Us, to my list AND hide my worksheet, here’s how. 

1. Click in the Client List tab and right click on Georgy 

Porgy, 

2. Click Insert from the shortcut menu, 

3. The Insert screen appears as displayed at right, ensure 

Shift cells down is selected, 

4. Excel inserts a blank cell for you– I want my list to 

remain alphabetical and remember to always add 

information within a range not at the beginning or at 

the end of your list, 

5. Type Geeks R Us in cell A11 and press enter, 

6. Right click on the Client List worksheet and from the shortcut menu 

click hide; Excel hides your Client List.  

7. Back at your Jan tab, click the client list and notice that Geeks R Us 

displays in your list. 

 To add another client or edit your list you would unhide the worksheet using the worksheet 

shortcut menu and delete or insert cells as necessary for your list.  
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Our final validation rule is a range of numbers to ensure the accuracy of our input. 

1. In the Jan worksheet, select columns D through F,  

2. On the Data tab, click Data Validation and from the menu click Data 

Validation and the Dialogue box opens, 

3. In the Settings Tab choose Decimal in the 

Allow area, 

4. Choose Between for the Data, 

5. Provide 0 for minimum and 10 for maximum. 

 

 

 

6. Next, click the Input Message tab and enter a 

Title and Input Message, 

 

 

 

 

 

 

7. Next, click the Error Alert tab, 

8. Use a Warning Style, 

9. Enter the Error Message and click OK. 

In your Jan worksheet, type 12 in a Word cell. 

Notice the Error Alert message, click Yes to 

accept the number 

Data Validation is a great way to protect your data from 

incorrect entries or typographical mistakes.  As you can see, 

data validation helps users on input and is not difficult to 

establish once you understand the process we have just accomplished. Next, we will use Data 

Validation for our function criteria.  Congratulations!  You and your data are valid.  
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Macros 

Ma cro  Overv i ew  

Macros are programmed shortcuts.  All of the Command buttons on the Ribbon are macros; the 

buttons represent pictures that execute code for Excel to accomplish. Macros save time and 

keystrokes by recording your keystrokes as you perform them.  This is the basic Macro.  Unless 

you want to become a Visual Basic programmer, this is how we use Macros to create time 

saving features and prevent repetitive steps and  input.  Macros are not bad and are very helpful; 

however, macro viruses that evil programmers and others code that can hide in files and 

applications create bad macro viruses. That is why we must create Macro Enable workbooks 

with a different extension of .xlsm. 

You should write down your macro steps and review the process prior to recording a macro, 

especially a multiple step macro.  Also, you may delete and edit (if you are comfortable with 

Visual Basic) macros.  You can view all of your macros and delete or alter them by Choosing 

Macros in the Developer tab..  We will create three macros and assign them to buttons on our 

Quick Access Toolbar and run them through keyboard shortcuts, too. 

 

Before we can create and work with macros you need to ensure that your Developer tab is 

active. 

1. Click the File tab and tlick the Excel Options button, 

2. At the Customize Ribbon item, ensure the Developer 

tab item is checked, 

3. Click OK, and the Developer Tab appears on your 

Ribbon. 
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Here are the overall steps we will use to create a macro.  

1. On the Developer tab, click the Record Macro 

button, 

2. The Record Macro dialogue box opens for you to 

name your macro, assign a shortcut key character, 

and to save in the workbook.  You enter a 

description of your Macro here, too. Click OK.  

3. Excel will begin recording EVERY 

keystroke, click, menu selection, and 

character typing you perform.   

4. When finished, you stop the 

recording by clicking the Stop 

Recording button on your status bar 

or in your Developer Tab.   

5. Next, try it out using the keyboard 

shortcut you entered.  

 I use macros to automate spreadsheet printing, font 

styles, sorting/filtering data, and other events that 

require repeated keystrokes that I consistently perform. 

 

First, we will create a simple macro that will type our name and company and provide the 

formatting we select.  Macros record our clicks, typing, selections, etc.  Macros do not record 

the time it takes, so be careful, slow, and sure. 

☹ Very Important Gotchas!  

1. Undo does not work on macros. If you run a macro and don’t like the results, 

OOPS! Undo won’t undo. 

2. If you use a keyboard shortcut for your macro, the macro overwrites existing 

shortcuts. For example, I used CTRL+S to run a sorting macro. Guess what 

that workbook never did again using CTRL+S? SAVE! The workbook 

sorted nicely with CTRL+S but did not save anymore. ☹ 
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Fo rma t t ing  Ma cro  

Macros may require a lot of computing power. Depending upon your 

computer, the process may be slow or cause “freeze-ups”, especially if you 

have several applications and files open and active. 

I created a workbook, Macro.xlsm, for us to use. When you open this you 

may need to enable the macro content. 

 

   If you want the macro to always go to a specific cell for the entry, start your macro 

first and then click the cells where you want the items placed.  This is what we will do.  If 

you do not what the macro to begin at specific location, don’t click a cell or column after 

the macros begins. Also, the Developer Tab offers you to use Relative Reference.   

 

1. Open the Macro.xlsm file, and click the Format Macro worksheet, 

2. On the Developer Tab, click the Record Macro Button,  

 An Important Gotcha! Macro names cannot contain a space or 

special characters!   

1. Type MyFormat as the Macro name. 

 

2. In the Shortcut key section press Shift 

and the letter f.  Excel keeps the CTRL key 

for you, only press Shift and the letter F. We 

need to be careful in assigning these 

shortcut keys because most of the Ctrl + a 

letter keys are assigned already. For 

example, CTRL + n activates a New 

Workbook and CTRL + f  activates the Find 

Dialogue box. Macros will allow you to 

overwrite existing shortcut keys. I don’t use 

this shortcut CTRL + SHIFT + F; I’m not 

sure what it does, if anything.  

3. Save the macro to the Personal Macro Workbook using the drop-

down arrow’s pick list; you can reuse this macro in other workbooks 



Page 48 Excelling at Excel: Advanced Level 3  Greg Creech 
  www.gregcreech.com 

Thank you for Learning!  Techedutainment Services, Inc.  Greg Creech © 2018 
No Duplication Permitted  404-403-5391 

and worksheets. You could save the macro only in this workbook or in 

new workbooks. 

4. Type in appropriate comments in the Description section, and click 

OK. 

5. The macro is recording and may signify this on your status bar. 

When we are finished recording our macro, we will click Stop Recording 

on our Developer tab. 

1. Click cell E1, carefully type your name as you want it to appear, then 

type your company’s name as you want it to appear and press enter. 

2. Click and drag to select Cells C1 through J1 – we want to give 

ourselves plenty of space for formatting. 

3. Click the Merge and Center button, 

4. On the formatting toolbar change your font, 

5. Change your font size, 

6. Click the Bold and Italic buttons, if like, 

7. Change the Font color and the Fill color, 

8. Make other formatting changes as you like. 

 An Important Gotcha! Even if a tab or item is selected, you must reselect it so the 

macro records your item. For example, if Times New Roman is your default and you 

want Times New Roman font in your macro, you must select it or click it again; 

otherwise, whatever default font is present when you run the macro will appear.   

9. Click cell A4 – this is where your cursor is 

after the macro runs, 

10. Click the Stop Recording button on your 

Developer Tab. 

11. Go to another worksheet, 

12. Click a cell, 

13. Press the CTRL key and the Shift key and 

the letter “f”  key all at the same time. 

14. Your macro executes for you. Notice your most valuable Undo button 

– grayed out ☹. 
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Wow!  A time saver for you. 

 

☺ Note if you accomplished this correctly the first time you are a genius and Excel expert.  I 

create all kinds for formatting macros to type information in certain fonts, shading, borders, 

and so on.  ☺ 

 

A Pa ge  S e t - up  Ma cro  
Let’s create a page set-up macro that will print our worksheet in landscape and format 

columns as numbers, dates, and text.. You can start and stop your macros using the Status bar 

or the Developer tab command buttons. 

 

1. Open the Macro.xlsm workbook, and click the Page Set-up sheet. We 

will record a printing and page set-up macro for this workbook. 

2. On your Developer tab, click the Record Macro button, 

3. Name the Macro – PageSetup (Remember no spaces), 

4. Assign the Shift +P key  to the Shortcut key so our macro will be run 

with CTRL+SHIFT+P (The CTRL+SHIFT+P 

shortcut opens the Format Cells at the Font tab; I 

never use that shortcut, so the macro can 

overwrite it), 

5. Ensure that we will store this macro in the 

Personal Macro Workbook, so we may use this 

macro in all Excel files. 

6. Type in a description, 

7. Click OK and the Macro begins recording. 

This is a popular type of macro, because after downloading 

information into Excel you will probably need to do much formatting for the type of values in 

the columns and then set your worksheet for printing. 

1. Format Column A  (Order) as a Number with no decimal places, 

2. Format Column B (Date) as a Date, 

3. Format Column C (Customer) as Text, 

4. Format Columns D-H as Numbers,  
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5. Format Column I as Currency with no decimal places, 

6. Format Column J as Text, 

7. Format Column K as a Percentage, 

8. Click the Page Layout tab,  

9. Click the Orientation button and click Landscape,  

10. Change your margins, 

11. Perform other page set-up items. 

12. Click Stop Recording on your Developer tab. 

13. Click the Page Set-up Practice Macro worksheet, 

14. Press your shortcut keys CTRL+SHIFT+P and the columns format for 

you and prints in landscape. 

A So r t ing  Ma cro   

We will use a macro for a specific workbook to perform sorting for us and our worksheets. 

1. Open the Macro.xlsm workbook,  

2. Click the Sort Macro worksheet, 

3. Click the Record Macro button on your 

Developer Tab, 

4. At the Record Macro Dialogue box name 

your macro MultiSort. 

5. Give a keyboard shortcut of Ctrl+Shift+S by 

pressing the Shift + S key in the Shortcut 

key box. 

6. Store the macro in This Workbook. 

7. Give a description of your macros, 

8. Click OK and your macro begins recording. 

9. Click in the data table and then click the Custom Sort button on the 

Data Tab, 
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10. Add levels and change your 

sorts as displayed here, 

11. Click OK, and Excel sorts your 

worksheet, 

12. Stop your recording by 

pressing the Stop Recording 

button your Developer Tab. 

13. Sort your worksheet by Order 

number. 

14. Press your Ctrl + Shift + S keys and watch as Excel magically sorts 

your worksheet. 

15. Sort by customer and then run your macro again. 

 

Ma cro  S ecu r i t y   
As I wrote at the introduction of macros, macros pose a security risk with malicious code that 

someone may have put in your Excel file. Therefore, Microsoft Office offers security measures 

for you in the Developer tab and the Macro Security button. The Macro Security button opens 

your Trust Center for how you want to handle macros. If you have an IT department, they may 

have stronger protection that won’t allow workbooks with macros on your computer.  

 

 Hot Tip! Pay 
attention to the 
enable content 
button when you 
receive an Excel 
file with a macro, 
if you don’t know 
or trust the 
person, don’t 
open the 
workbook or 
enable the macro 
content.    
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Ed i t ing  a  Ma cro  

You may want to edit or delete your macros. 

1. First, be in the workbook that contains your 

macro to edit or delete your macro. 

2. Click the Developer tab and click the Macros 

button, the Macro dialogue box appears.  

3. I am in the Macro.xlsm workbook. Select the 

Macro you wish to run, edit or delete and click the 

appropriate button for editing, running, or 

deleting. 

Note that the PERSONAL.XLSB macros are stored 

in the Personal Macro Workbook and can only be 

deleted or edited if you unhide the 

PERSONAL.XLSB workbook.  A Message 

box appears when you try to delete or 

edit a macro in the PERSONAL.XLSB 

file.  

 

If you are ready for VBA 

programming then you may edit 

your macros, as displayed here. 

This is the scary place for me, so I 

quickly exit. 

Let’s Unhide the PERSONAL.XLSB file 

and look at the macros. 

1. In your Macro.xlsm file, click 

the View Tab and click the 

Unhide button. 



Greg Creech Excelling at Excel: Advanced Level 3  Page 53 

www.gregcreech.com 

Greg Creech © 2018 Techedutainment Services, Inc.  Thank you for Learning! 

404-299-1706  No Duplication Permitted 

2. We have used the Hide and Unhide features 

for columns and worksheets, but not 

workbooks.  If we have nothing selected, 

Excel will assume we want to hide the entire 

workbook.  

3. After clicking the Unhide button, the Unhide 

pane appears for you to select, if it isn’t 

already, the PERSONAL.XLSB file and click 

OK. 

4. The PERSONAL.XLSB file opens for you. 

5. Click the Developer tab and click the Macros button.  

6. Now, you can edit and delete these macros. 

7. After viewing your macros, click OK. 

8. On the View Tab, click the Hide button to hide your PERSONAL.XLSB 

file. 

  

If you were to edit a 

macro, Excel takes you to 

Visual Basic as displayed at 

right.  Now you are ready 

to be a programmer! 

 

 

I use macros for all sort of printing 

items, too.  You can select multiple 

worksheets to print and assign 

headers and footers to grouped 

sheets.  There are many, many uses for macros and hopefully you’ll find this section helpful as 

you build your own shortcuts using macros. 

 

While this is nice, I’ll never remember these shortcut keys.  Let’s go add command buttons to 

our Quick Access Toolbar that will run our macros when clicked.   
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 Ma cro s  Ass ig nmen t  

We have keyboard shortcuts for our Macros; however, we also want a button to press to run the 

macro.  For a refresher on the Quick Access Toolbar and command buttons please refer to the 

earlier section of this book or my Excelling @ Excel: The FUNdamentals book for how to 

change and add commands to our Quick Access Toolbar.  

 

1. Right click on a command button on the Ribbon,  

2. From the shortcut menu, click Customize Quick 

Access Toolbar, and the Customize pane opens, 

3. In the Choose command from section, scroll down 

and locate Macros.   

4. Select each macro and click the Add button to add the macro to your 

Quick Access Toolbar. I’m adding my MultiSort, MyFormat, and PageSetup 

at the end of my Quick Access Toolbar. 
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5. Next, change your button symbol or image by selecting the Macro and 

clicking the Modify button at the bottom of your customize box. 

6. The Modify Button pane appears for you to choose your button and 

rename your button. I have chosen 

a button and named the macro’s 

button Sorts by Total, Customer, 

Date, and Order.  

 

 

 

 

 

 

 

7. Change the button and the button’s name for your other macros by 

selecting the macro in your button pane and clicking the Modify button. 

Next, choose your new image and change 

your Display name box.  

   Hot Tip! Excel allows you to 

customize the Quick Access Toolbar 

for all files or for a specific Excel 

files. If you have a macro designed 

for only one workbook, then you 

may add that button to the file that the macro applies. You 

must have the workbook open with the macro to add it to 

your toolbar.   

My images and names appear here. 

Click OK. Open a new workbook and try 

out your format button. 

Congratulations on creating your own 

macros and buttons.  Now that wasn’t SOOOOOOO bad.   
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More Functional ity with Functions 

Tex t  Fun c t io n s  
Text functions are easy and powerful. We’ll bring columns together using Concat and learn how 

to change case in Excel, and other ways of working with and displaying text data. 

Hey Mate! Let’s CONCATENATE!  

In 2013/2016 Excel the function is Concat; in previous versions the 

function was Concatenate. This great and easy function still brings 

separate columns together to act as one. 

Concatenate is a fancy word for bring together or consolidate.  The 

Concat function in Excel consolidates two or more columns into one 

column.  For example, you may want your First Name and Last Name 

columns in one column entitled Name or maybe you want your City, State, and Zip Code 

columns as one.  

Hot Tip!  Concatenating columns makes mail merge from 

Word easier and less cumbersome with working with one 

column rather than 2 or 3.  Concat aids in sorting and in 

PivotTables.  

We’ll use the concat function on our Database Functionality file and Concat worksheet to 

consolidate the Last Name and First Name Columns. 

1. Open the Excel Workbook entitled Database Functionality and select 

the Concat worksheet/tab, 

2. We’ll insert two columns for our concatenated columns. One Column 

for Name and one column for City, State, and Zip. 

3. Right click the column E Header or the Home Street Line 1 column and 

from the shortcut list, click Insert.  A new, blank column inserts for 

you. 

4. Right click the column header J and from the shortcut menu, choose 

Insert.  A new, blank column inserts for you.  

Excel 2013/2016 – 
Function name change 
Concatenate to Concat.  
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5. Click cell E1 and type Name. You will want to widen 

your column for the names to fit. 

6. Click in cell J1 and type – City, ST, ZIP. You will want 

to widen your column for City, ST, and ZIP to fit. 

7. Click the Formulas Tab and the Text Command 

button and choose Concat from the list.  

8. In the Function Arguments Dialogue box for Concat 

enter C2 (by typing the cell reference C2 or clicking the 

cell C2) in the Text 1 box, 

9. In the Text2 box enter D2 (by clicking the cell D2 or 

typing D2), 

10. Excel displays that the function is working for you. 

11. Click OK. 

This is fine, except we want a space between the First Name and the Last Name, so we will 

need to edit the function. 

1. Click in your formula 

bar (or use the 

Function Arguments 

box displayed here) 

and edit the formula. 

We accomplish this by 

typing a quotation 

mark, pressing our 

spacebar, typing 

another quotation 

mark, and typing a 

comma. 

2. The function now reads 

=CONCAT(C2,” “,D2) 

and the name has a 

space in it. 
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3. Finally, double click your fill handle in cell E2 to copy this function 

through your list. 

Now, let’s edit the function so our names will be by Last Name and then First Name with a 

comma separating them. 

1. Click in cell E2 and in the formula bar edit the function as follows: 

2. Change C to D in the first cell reference (so cell D2 is the first cell 

reference), 

3. Type a comma after the 

quotation mark and before the 

space, 

4. Change D to C in the second cell 

reference (so cell C2 is the second cell reference), 

5. Press enter and double click your fill handle in cell E2 to copy this 

function through your list. 

6. Finally, click the Sort Ascending button to automatically sort your list 

by Last Name and then by First Name. Using Concat with these 

columns allows me to sort by Last Name and First Name without using 

the Custom Sort box.  

So, our Concat function aids in formatting, functionality, and in sorting.   

Now, let’s practice concatenation with our City, State, and ZIP code columns in the inserted 

K2 cell. 

1. Click in cell J2, 
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2. Activate your Insert Function Dialogue box and from the Categories 

insure Text appears 

and select the 

Concat Function 

from your list. 

3. The Function 

Arguments 

dialogues box 

appears and in the 

Text1 box type or 

click cell G2,  

4. In the Text2 box 

type “, “ (quotation 

mark, comma, space, quotation mark), 

5. In Text3 box type or click cell H2, 

6. In Text4 box type “ “, (quotation mark, space, quotation mark), 

7. And finally, in the Text5 box type or click cell I2, as pictured above for 

you. The function should read:  =CONCAT(G2,”, “,H2,” “,I2), 

8. Click OK. 

9. Finally, double click your fill handle in cell K2 to fill this down through 

your list. You may need to widen your columns to see your 

concatenated information. 

Your city, state, and ZIP Code have appropriate spacing now for a mail merge or other use. 
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There is another 

function similar to 

Concat that includes a 

delimiter for you. 

Here’s a screenshot of 

the JOINTEXT 

function for Last 

Name and First Name 

separated by a comma 

and a space.  

 

The difference 

between CONCAT 

and TEXTJOIN is I 

enter the delimiter of a 

comma and space in 

the Delimiter box 

using the TEXTJOIN 

function instead of 

using a Text box for 

my delimiter. The City, 

State, and ZIP 

concatenated column wouldn’t work with TEXTJOIN, since I used different delimiters.   
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Upper,  Lower,  and Proper  

Clients have asked where are the case buttons for text (uppercase, lowercase, and proper), and 

this being Excel, I reply these are functions 

in Excel. These functions are easy because 

you simply use the function and reference 

the cell you wish the change the case. So,  

here is the syntax for these functions: 

Lowercase: =LOWER(B2) 

Uppercase: =UPPER(C2) 

Proper: =PROPER(V2) 

☹ Important Gotcha! Be careful with 

proper, it capitalizes the first characters, 

so names like LaTonya and McCants 

won’t have subsequent characters with the capitals. ☹  

Practice inserting columns in the Concat worksheet and using these case functions. 

Left,  Right, and Mid 
Often, we want to use only certain characters of a text string, for example the 

last four digits of an account number or Social Security Number. The LEFT, 

RIGHT, and MID functions accomplish this for you.  

 

1. Using the Concat worksheet insert a column at column H. 

We want the last four digits of the SSN and the columns do not 

have to be adjacent. 

2. In cell H1 type 4 Digits, 

3. In cell H2, using your Text function list choose RIGHT, 

which displays the number of characters from the end of a text 

string, 

4. The Text is cell A2 that has our SSN, 

5. The Number of characters is 4, 

6. Click OK and the last four digist of the SSN displays. 
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☹ Important Gotcha! You may need to 

format your column as text to see the 

leading zeros. ☹ 

The Left function measures from the 

beginning of a text string and the Mid 

function measures from the middle of 

your text.  

 
 
 
 
 
 
 

Value, NumberValue and DateValue  
When you download data from a database or website, Excel may not provide the correct value, 

since it uses the General formatting. Even when you turn a column into an Excel format like 

Date, the data will not work as a number or date only text, so sorting won’t work. Similar to the 

UPPER and LOWER functions, you reference a cell to change the value. This is the case for the 

Database Functionality workbook and worksheets; I downloaded this from an Access database 

and the dates did not convert well. 

1. In your Database Functionality file and in the Personnel worksheet, 

click in the Birth Date column and sort it. OOPS! The Birth Date column 

sorts as Text not a Date. The 

column is formatted as a 

Date and still won’t work. 

2. Insert a column after your 

Birth Date column, 

3. Type a title for your column, 

such as New Birth Date, 

4. In the cell beneath, insert 

the DATEVALUE function. 

You only need to reference 
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the cell you want to change the value: =DATEVALUE(Q2). Press enter 

or click OK. 

5. Fill your DateValue formula down the column and then sort your data 

that works great now and sorts chronologically.  

 

The Value and NumberValue functions work the same way and takes text 

and converts it to a number. There are plenty of other text functions to help 

including REPLACE, SUBSTITUE, and REPT.  

 

 

 Write your notes here:_________________________________________________________ 

 

________________________________________________________________________ 
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Da te  Ca lcu la t ion s   

Since Excel is so great with formulas and functions using cell referencing and numbers, it is 

terrific at Date Calculations, too, such as age and service anniversaries calculations.  You do not 

want to manually enter an age, unless you want to constantly update your worksheet with the 

correct age and we grow older by the day.  We will look at several different age calculations.  

Let’s first examine how you can calculate age and service anniversaries that are based on a Date 

of Birth and Hire Date and using the TODAY() function. 

 Please ensure that you format your dates as date, such as Short date, using your format 

cells dialogue box.  Also, Excel stores your dates as numbers.  Every day since 01/01/1900 is a 

serial number, for example 01/01/1900 is stored as 1 and 01/01/2008 is 39448. That’s how 

Excel can compute time intervals.  

1. Open a new blank workbook and in cell A1 enter your date of birth. 

(You don’t have to use the correct year, if you don’t want to; I have no 

shame so I am entering my actual birthdate of 04/02/1958. Yes, Excel 

can count that high!) 

2. Enter this Formula in cell 

B1:  =Today()-A1. Press 

enter. 

OOPS! You may need to format 

column B as a number if you have date format in cell B1. I changed my B1 

cell from a Date to a Number format with no decimal places. 

3. Wow, this measures our age in days.  The TODAY() function is the 

current date on your computer and measures your dates in days. I am 

typing this on 07/12/2017, so 21651 is the number of days I have lived 

as of 07/12/2017. 

4. Fill this formula down a few cells, and in cell A2 type a more current 

date. This is popular to know for time intervals for shipping, ordering, 

billing, and other important business information dates.  I used this for 

knowing when an account’s Account Receivables went above 30, 60, or 

90 days. 

 

Now, let’s change our age to years. 
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1. Now, let’s use years – change your formula to read: 

 =(TODAY()-A1)/365.25.  Your information is expressed in years, but 

Excel rounds, because I formatted as a number with no decimals! 

 

Notes on the Formula: If you do not put in the 365.25 division, this will 

calculate the 

number of days. 

The .25 in the 

365.25 figure is 

for leap years. 

Excel started 

tracking days on 01/01/1900. Also, notice I had to put in my parentheses 

before TODAY and after A1; otherwise, Excel would do my division first and 

then my subtraction following our order of operations. I would really not 

like that number!  

2. Here’s how to use the ROUNDDOWN function to prevent rounding our 

age up. I changed my birth month, so Excel rounded my age to 60! 

3. Click in Cell B1 and edit the formula to read:  

=ROUNDDOWN(((TODAY()-A1)/365.25),0) 

4. This will accomplish exactly what you want.  The number of 

parentheses can be tricky and the 0 is the number of decimal places 

that you want. 

5. Save your workbook as Date Calculations. 

 Write your notes here: ______________________________________________________ 

_______________________________________________________________________ 
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Now, let’s calculate the Age at which the associate was hired.  With this formula we won’t 

use the TODAY() function but we will compare two dates and use the YEAR Function.  For 

us the dates will be the Birth Date and the Hire date. 

1. Open the Database Functionality file, 

2. With your Personnel File Workbook open, click in cell W2, 

3. Notice the formula =YEAR(U2)-YEAR(Q2). This 

provides how old these people were when we hired 

them and the time interval in years.  

4. You may delete the contents of these cells and recreate the formula. 

 

Next, with Length of Service, let’s have the ability to show partial years.  As a Human 

Resources Manager, I needed to know parts of years rather than 

whole years. 

1. In Cell X2, notice the Formula  

=(TODAY()-U2)/365.25 

2. You may need to decrease or increase your 

decimal places as you like. 

3. This is similar to our age calculation, but using 

our hire date. 

 As related previously, if you want to compare an Order date verses a Ship Date or 

Purchase date verses an Warranty Expiration date you may want to use days or months.  

If you like, you may use the ROUNDDOWN function has described above.  Also, when you 

change a Birth Date or Hire Date your calculations change too. 

There are other functions to check out, too.  You may use the 

NETWORKDAYS to measure Workdays rather than including Weekends.   You 

may want to use the MONTH function to calculate based on months.  Check 

this out on Excel’s help with functions. 

 

Looko u t  fo r  Look Ups  

Using Excel as a List or Database tracking system allows the program to populate information 

from another area of a worksheet or from an entirely different worksheet.  This can eliminate 
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duplicate input and can quickly locate specific information for you based upon criteria.  While 

there is a Lookup function that will lookup one row or one column of data the VLOOKUP and 

HLOOKUP functions are more powerful and popular because they can use multiple columns and 

rows. 

 

If your worksheet is a vertical type of worksheet, that is where the data is in columns use the 

VLOOKUP (Vertical Lookup) Function.  If your worksheet is a horizontal type of worksheet, 

that is where the data is in rows use the HLOOKUP (Horizontal Lookup) function.  The Vertical 

Lookup function will lookup information in columns; the Horizontal Lookup function will 

lookup information in rows.  We will use the Vertical Lookup (VLOOKUP Function). 

 

The ExcelVLlookup workbook contains a vertical lookup for us to examine. 

1. Open the ExcelVlookup file. Click on the Product Sales sheet, notice 

the figures in the Date column – these numbers are retrieved from 

the individual sheets.  Navigate to the August 1 tab and change a 

number for a Product – click back on the Product Sales sheet and 

notice the number updates automatically.  VLookup automatically 

updates a cell from another worksheet.   

2. Where you see a blank or #N/A the product code doesn’t exist on the 

other worksheets. Great for comparing worksheets and the missing 

data – this is popular for audits and reconciliation activities and a 

host of other needs when comparing the differences between 

worksheets or to populate and update a worksheet based on another 

worksheet. 

 

The Product Sales worksheet retrieves its information from the other worksheets.  Each day a 

worksheet downloads from a server illustrating the Product Code sales for each day.  As a day is 

added as a worksheet, the Product Sales worksheet needs to have a column added and the 

vertical lookup function modified to reflect the additional daily sales.  Of course, in the “real 

world” you would copy the VLOOKUP function and edit it; however, for our exercise we will 

develop a new Vertical Lookup function.  The Product Sales worksheet “looks” at the other 
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worksheets and compares the Product Code and based upon the Product Code the value in 

Column B is returned. 

 

 Hot Tip! This is another area in which using a Named data 

range is very helpful; otherwise, you may need to use 

Absolute Reference using the $ signs.  I encourage you to 

name your area to reduce frustration and mistakes. I will use 

the name Aug2Sales for our exercises here.  

 

Here are the steps and our exercise for using Vertical Lookup to retrieve information based 

upon Product Code from another worksheet (August 2). 

1. Open the ExcelVloopup workbook 

and Click the August 2 tab and 

select Columns A & B (this is the 

area from which we retrieve the 

data). In the Name box type 

Aug2Sales and press enter to name 

this area. 

2. Click back in the Product Sales 

worksheet and click in Cell E3 – this 

is where we will construct our 

VLOOKUP function. 

3. Click the Formulas Tab and in the 

Function Library Group click the 

Lookup & Reference item and from 

the menu select VLOOKUP.  The 

VLOOKUP function dialogue box 

activates. 
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4. If your Function Arguments box covers your data, click at the top of 

the dialogue box and move it.  

5. Lookup_value is the column or cell(s) that contain the item you wish 

to have Excel to compare in order to find the data for that item.  In 

our case, the Product Code information is retrieved and this 

information is in Column A. 

6. Click the Column A column header in the Product Sales worksheet, 

7. The Dialogue box displays A:A, 

8. Next, Excel needs the area containing the data.  This is signified by 

the Table_array box.  The Table_array can be a range of cells, 

columns, rows, etc.  We named our area Aug2Sales.   

9. Click and drag Column A and B in the August 2 worksheet or type 

Aug2Sales – Excel places this name in the Table_array box for you. 

10. Excel needs the column number from our table array or data area.  

We will use Column B from our area and Column B happens to be the 

second column in our array.  Type 2 for the Col_index_num.  Press 

Tab. 
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11. In our worksheet we need an EXACT or precise match for the data 

since we have specific product codes; therefore, type FALSE in our 

last row. 

12. Click OK. 

13. Finally, using the ever popular Fill Handle, click the in cell E3 and 

double click the AutoFill Handle to fill the remaining cells.  

14. Click on the August 2 tab and at the bottom of the product list add 

10102 and in the second column type a number. Click back on your 

Product Sales worksheet - your information automatically populates. 

  Note:  If Excel does not find a match it populates the worksheet with N/A. 

Let’s practice another Vertical Lookup.  This time we will enter a product code in one cell and 

the sales for that product code will display in another cell. 

1. Click the August 1 worksheet. 

2. Notice cells D1 through E2,  

3. In cell E1 type 10400, 

4. Cell E2 displays 12, 

5. Scroll down your worksheet to the Product code of 10400 and notice 

that Excel is displaying the correct number.  Change the cell from 12 

to 15. 

6. Scroll back to the top of your worksheet, notice E2 displays 15. 

Let’s add this “function”ality to our August 2 worksheet. 

1. Click the August 2 worksheet, 

2. Click cell E1 and enter 10101, 

3. Click cell E2, 

4. Click Formulas Tab and click the Recently 

Used button and from the menu choose 

VLOOKUP. 

5. The lookup value is cell E1 – either type E1 or using the collapse icon, 

click cell E1.  

6. In the Table_array box type Aug2Sales or click and drag Columns A 

and B  (The name of our range of cells containing our lookup data), 
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7. The Col_index_num is 2, 

8. The Range_lookup is False, 

9. Click OK, 

10. In cell E1 enter another Product Code and notice the changes in Cell 

E2. 

This is popular in using a huge worksheet to display specific information and is much quicker 

than using the Find feature and using the Filter items. We will use the VLOOKUP function in the 

same manner in our next section, but we will have more columns.  

 Write your notes here: ______________________________________________________ 

_______________________________________________________________________ 
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I f Error  Fun c t ion  

Excel will put #N/A if a value is not found in the Lookup.  You may not want Excel to display 

this and display nothing or other text.  Excel’s new IFERROR Function allows you to specify 

the error display.   

Here’s how to use the IFERROR function. 

1. In your VLookup workbook and the Product Sales worksheet, Click cell 

E3 with your VLookup Function. Edit the function and add the IFERROR 

Function like this:  

=IFERROR(VLOOKUP(A:A,Aug2Sales,2,FALSE),””).   

2. Fill down your edited function by double clicking your Fill Handle for 

this cell or clicking and dragging down to the end of your list.  Excel 

replaces the #N/A with a blank because we used double quotation 

marks in our IFERROR function. 

 

You can put words or other characters between the quotation marks to 

further customize your error message as displayed below after editing my 

VLOOKUP on the August 2 tab.   

While you may use the Function Arguments box to accomplish the IFERROR function I have 

found that the Function Arguments become the Function Cursing box for me as I find it easier to 

edit using the formula bar than the dialogue box. 

 Write your notes here: ______________________________________________________ 

_______________________________________________________________________ 
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Mo re  VLOO KU P  

As you have seen VLOOKUP makes retrieving data on huge worksheets easy and accurate.  

We will use VLOOKUP on a demographic and Human Resources type of workbook, now. 

1. Open the Database Functionality workbook, 

2. Click the Vlookup Complete tab and at the top of the worksheet 

notice the Sales ID box.  When you enter a Sales ID in cell A2, 

VLOOKUP retrieves key information about that person.   

3. We will create these VLOOKUP functions on the next tab. 

4. Click the VLookup Practice worksheet and in cell A2 enter a Sales ID 

of 18. I have named this cell LkpSalesID and I have named the 

database/table PersonnelDB. 

5. Click in cell B2, click the Formulas Tab and in the Function Gallery 

choose Lookup & Reference and from the menu click VLOOKUP. 

6. The VLOOKUP Function Arguments pane appears. 

7. The Lookup_Value is the Sales ID box or cell A2 – LkpSalesID. You 

may type LkpSalesID or click cell A2.  
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8. The Table_array is PersonnelDB – you may find it easier to type this 

than to select the database area, 

9. The Last Name is in Column 4 of our database/table so the 

Col_index_num is 4. This is the fourth column in our table that 

happens to be Column D. 

10. We want an exact match so FALSE is in the Range_lookup area, 

11. Click OK. Bunney should appear in Last Name. 

12. Copy and Paste or use AutoFill to copy this function from Cell B2 to C2 

and change the column number from 4 to 3 (The First Name column 

in our table/array  and notice Buggs appears in this cell). 

13. Practice copying and pasting this function in the other cells and 

changing the column that it references for Bonus, Percentage, etc. 

 A Hot Tip! Know column or row numbers, you can click and 

drag across column or row headers and Excel displays the 

Column and Row number for you.  You don’t 

have to start the numbering at Column A or Row 

1; Excel magically displays the row and column 

number for you as you click and drag across 

your column or row headers. Percent is in 

column 13 for my VLookup function. So, 

VLOOKUP is easy once you get it right. Simply 

copy/paste or Autfill the function to another cell 

and change the column number.  

This is where using the Name Box for Absolute Reference is helpful; otherwise, Excel would 

change our Sales ID (LkpSalesID) cell from A2 to B2 after we copied the function from cell 

B2 to C2 plus it would change our lookup table-array reference, if we used regular (relative) 

cell references.  

 

On Your Own!  There is a worksheet entitled VLookup On Your Own – here’s 

the assignment using Column A – SalesID Look up the information in the 

column headings such as Last Name, First Name, etc. and beginning in B2 

create your VLookup to retrieve data from PersonnelDB in the VLookup 

Complete worksheet for these columns. Remember to use the Name box and 



Greg Creech Excelling at Excel: Advanced Level 3  Page 75 

www.gregcreech.com 

Greg Creech © 2018 Techedutainment Services, Inc.  Thank you for Learning! 

404-299-1706  No Duplication Permitted 

name column A SalesID. My VLOOKUP for Last Name appears here. After I 

complete this VLOOKUP I use AutFill to copy the function down my Column B. 

Next, I use AutoFill to copy my VLOOKUP function from B2 to C2 and then 

edit the VLOOKUP function from Column 4 (Last Name) to Column 3 (First 

Name).  

 

Now, repeat these steps for Dept, Bonus, and Age; remember you will need 

to know the Column number for these lookups.  

 

 Write your notes here: ______________________________________________________ 

_______________________________________________________________________ 
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HLO O KUP Fu n c t io n   

Now, let’s use the HLOOKUP function for our horizontal lookup and having our information in 

rows.  

1. Open the ExcelHlookup workbook. 

2. The HLOOKUP Complete worksheet uses cities with percentages (cells 

I1:Q2) as its Table_array, which I have named COLA. The HLOOKUP 

function is in cell B5. Based on the city, Excel retrieves the Cost Of 

Living Adjustment percentage and the New Salary updates. Also, notice 

how I am using Data Validation to  select a city from the list. We 

learned how to do this earlier and you can click this cell and enable 

data validation to see my settings for this list. 

3. Now, using the HLOOKUP Practice worksheet and cell B5, create a 

HLOOKUP. Here’s screenshot of my completed HLOOKUP Function 

Arguments box.   
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I f ,  Th en ,  OR El se !  

Excel has several If, Then, Else functions available.  We will examine the If, Then, Else using 

one condition and then we will use this for several conditions.  The first example is an 

Immediate If Then function and the second example is a nested If Then Else function.  Using 

more than one function together or various levels of calculations is called nesting.  We will use 

the If, Then, Else functions for text and for numbers. 

 

In our first example, if someone stays within or under budget they will receive the words good or 

bad in the If function cell. Then we will have various levels of being within budget, so the more 

money they have in a budget the words will change.  Finally, we will award bonuses based upon 

a percentage; this will be a nested If, Then. 

 

 Watch out for the parenthesis with the IF function!  This can get tricky with the 

number of parenthesis and is a common mistake to miss a parenthesis or put too 

many parentheses in the function, as you will see.  Also, use these examples to help 

you in forming your own IF, THEN functions – copy and paste one of these and 

change your reference cells and words/numbers.  

 

Let’s get started with a basic If Then first. 

1. Open your Budget Excel workbook, 

2. In cell E4, type Good or Bad and press 

Enter,  

3. In cell E5 and Formulas tab, click Logical 

and from the menu choose IF, 
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4. At the Function Argument box, the Logical_test is D5>=0 (if they have 

any money leftover they are good), 

5. The Value_if_true is Good! – Excel will put in the necessary quotation 

marks.  

6. The Value_if_false is Bad! – Excel will put in the necessary quotation 

marks; so if they go overbudget, they are bad. 

7. Click OK. 

This formula is saying: “If the cell D5 is greater than equal to 0, then 

provide Good in this cell, else Bad if the amount is less than 0.”   

8. Next, fill down your function. 

This type of IF function is also called an Immediate IF statement, since 

there are no other conditions.   

 

 This is another good use for the Name box.  In our next exercises, I will use a range Name 

of Difference and Percent for the IF function.  
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Now, let’s use more than one condition.  We will have Excel provide different words based on 

the amount of money left in the budget, for example, if we have more than 100, the word 

Excellent will appear, if we have more than 75 and up to 100, the word Good will appear, if we 

have more than 50 up to 75, the word Fair will appear, if we have more than 0 up to 50, the 

word OK will appear, or if we are over budget with less than 0 in our category the word Fired! 

will appear – let’s be good corporate citizens and not go over budget OR ELSE! 

1. With the Budget workbook open, click cell F4 and type Multiple If, 

2. Click Cell F5, Enter the IF Function as shown below. You should use the 

formula bar to create and edit this nested function. 

This is where the parentheses get tricky; thankfully, Excel gives color 

coded parentheses, so when you see the black parenthesis at the end of 

your closing parentheses, you are done. I have named cells D5 through 

D16 Difference. Also, you must type the quotation marks for the text 

values.  

 

Once this is correct in your cell F5, fill down through row 16. 

Why didn’t I use the Function Arguments dialogue box?  I find this function easier if I type in 

the information.  The screenshot above of the Function Argument Dialogue box shows you the 

function arguments of Value if false, which is too small for me to enter the function. 
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Now, let’s create a function that will provide a value or number rather than text.  In the next 

example, we will provide a bonus amount based upon a percentage.  If the percentage is greater 

than equal to 100, the bonus will be $1000; if the percentage is greater than equal to 95 up to 

100, the bonus will be $750; if the percentage 90 or more, the bonus will be $500; and so on until 

the percentage falls below 70, then the bonus will be 0. 

1. With your Database Functionality file open, click on the Personnel tab 

and click cell O2.  For this function, I have named the cell range in 

column N Percent.  Notice the function and delete the function from O2 

– O46.  Now, don’t click Undo! We will recreate the function. 

2. In Cell O2 type the Function as it appears below or use the Function 

Argument Dialogue box if you prefer for the IF Function.  

 

3. Again, be careful as it is easy to mistype or get something out of place.  

Also, if you do not want to use the percent you can use the number as a 

decimal, such as 100% becomes 1, 95% becomes .95, etc. whichever 

is best for you.   

4. Once complete and the function is working double click the fill handle 

in cell N2 to fill to the end of your percentages or click and drag down 

to the final percent row. 

The Excel Help provides additional information about this function with 

examples similar to ones I have used here.  You may have Excel perform 

calculations and functions for you based upon values in a cell, too. 

 

 Write your notes here: ______________________________________________________ 

_______________________________________________________________________ 
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While providing Values and Text are popular with If Then Else, using If Then Else to perform 

calculations is popular, too. We will use a quantity cell and populate a revenue cell using 

constructs for the product. 

1. Open the Database Functionality workbook and click in the Personnel 

Worksheet cell AB2. Notice the If Then Else Function; this is pictured 

for you below. 

2. This takes the value in Column Z and multiplies the value by a number 

based on the type of Plan in Column Z. We multiply the Value in 

Column Z by the Quantity in column AA using the IF THEN ELSE to 

determine which value to use in the calculation based on the Plan. The 

Else is 0.  

3. As I related previously, this is quite detailed and the commas, literal 

text, and parenthesis order matters.  

4. Delete the IF THEN FUNCTION in the column AB, let’s recreate the 

function using this screenshot as a guide. As I previously wrote, I find 

using the Formula bar to enter the information more helpful than the 

Function Arguments box.  

5. Once you complete this function is cell AB2, fill it down through the 

remainder of the rows, using your double click trick with Dr. Fill. 

 Write your notes here:_________________________________________________________ 

 

________________________________________________________________________ 
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Mo re  I f  Won d er s  –  SumIFS,  Averag eIFs  

Speaking of If, Excel has Functions that can use the Sum, Average, and Count Functions based 

on criteria. Excel has had a function that would calculate data based on a single criteria (SUMIF, 

COUNTIF, AVERAGEIF), but with Excel 2007-2016, the function expands to include more 

than one criteria and criteria range. We will perform sums based on account/client and payment.  

We will accomplish multiple and singe criteria for our functions.   

 

 Important Note: Using the Name box and Name manager for your Sum or Average Range 

and your Criteria ranges are far easier than selecting large areas for these ranges. This also 

helps in knowing the correct area by using names that describe your function and criteria 

ranges. For example, using the name Total is better than a range of I11:I99 to represent the 

area I want to use the SUMIFS or AVERAGEIFS functions. Also, using the name Customer 

for our criteria range is better than cells C11:C99.   

 

Let’s create several functions based on criteria. 

SumIFS 

1. With the IfThenSheet workbook open, click the Ifs Complete 

worksheet and notice Cells D4, D5, and D6 with the calculations for 

Sum, Count, and Average based on criteria.  Click these cells and notice 

the formula bar and the construction of these functions.  I am using 

names for the range and the criteria range and the information in 

quotation marks are the criteria for 

these items.  For example, if you click 

on Cell D4 and in the formula bar 

change the “Yes” to a “No”  and press 

enter, the cell will display orders that 

Computer Tech has NOT paid (BOO! 

HISS!).  

2. Now, click the Ifs Practice worksheet and click cell D4. Using the Insert 

Function menu, type SUMIFS and the function will appear. 

3. Select SUMIFS and press OK. 
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4. At the Function Arguments Pane enter Total for Sum_range or use the 

range of cells you wish to provide the Sum function. 

5. Next, in the Crieria_range1 enter Customer or the range of cells you 

wish for your criteria.  

6. At the Criteria1 box enter the text Computer Tech or other criteria for 

the Sum function to 

use. Excel inserts the 

quotation marks for 

you. 

7. Excel provides 

the Criteria_range2 

box after you enter 

your Criteria1 

information, enter 

the name Paid or use 

your range of cells 

for the second 

criteria. 

8. In the Criteria2 box enter the text Yes.  

9. Click OK and Excel returns the Sum of $4,350. 

10. Now, edit your formula bar so that the “Yes” is a “No” and notice how 

the criteria and result changes for you.   Next, change Computer Tech 

to Bates Motel in the formula bar.  If you prefer using the Function 

Argument box to modify your Criteria you may do so.  Play around with 

different customer names. 

 

☹ Important Gotcha! Using the Formula Bar or Function Arguments box to change 

our criteria is tricky; the criteria must be exact plus a novice Excel user may not 

know how to change the criteria easily for you. Data Validation ensures accuracy and 

makes our functions more “user-friendly”. We will use cells with our criteria in a list 

to select the criteria for our functions. ☹ 
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Data Validation for Cri teria 
With the HLOOKUP function, I created a list from which to choose a city for HLOOKUP to 

lookup. With functions like SUMIFS, AVERAGEIFS, and COUNTIFS using a drop-down list to 

select criteria is easier and more accurate than editing the formula bar or using the Function 

Arguments box for your criteria. We’ll learn how to create a list from which people may choose 

their criteria. 

 

With your IfThenSheet.xlsx workbook open, click the Ifs Complete Data Validation 

worksheet, notice cell D3 with a drop-down list, select a client from the list and your SUMIF 

function updates based on the customer in cell D3. Also, notice cell F4 that has Yes or No 

from which to choose. For example, change cell D3 to Bates Motel and cell F4 to No and see 

how much Norman owes me. Since we covered Data Validation in detail earlier, I’ll display 

my Data Validation screens below for you to create your own list. 

1. Open the IfThenSheets workbook and click cell D3 in the IFS Practice 

Data Validation worksheet. This is where we will insert our customer 

list using Data Validation. 

2. Also, Column N contains our Client List that I named Customers. This is 

our list we will use for our criteria. After using this list in my function, I 

hide Column N. 

3. Using Data Validation for cell D3, the Settings Tab allows a List and the 

source is our Customers list. We don’t need an input message, but if 

someone tries to type a name or use a name not on our list, we want to 

provide a nice error message as displayed here in my Error Alert 

screenshot. Click ok and now you may choose your criteria from your 

list. 

  



Greg Creech Excelling at Excel: Advanced Level 3  Page 85 

www.gregcreech.com 

Greg Creech © 2018 Techedutainment Services, Inc.  Thank you for Learning! 

404-299-1706  No Duplication Permitted 

Now, let’s use cell F4 for our Paid criteria Yes or No. 

1. Using our Data Validation for cell F4, the 

allow is a List and you may enter your list 

separated by commas. Our list is easy with 

only Yes, No, as displayed here.  

2. We don’t need an Input Message or Error 

Alert. Click OK and now you may choose Yes 

or No in cell F4. 

Now, time for our SUMIFS in cell D4. 

1. In cell D4, insert a SUMIFS function. At 

the Function Arguments box, enter the 

information based on this screenshot. 

2. I’m still using Names for my Sum and Criteria ranges, but I’m not 

typing the criteria. I reference cells that have the criteria with my 

Data Validation.  

3. Click OK. Now, change customers in cell D3 and change paid in cell F4 

and notice your cell D4 how it sums based on your selections. 
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I guess by now, you know how much I love Naming. Here is my SUMIFS on 

the Ifs Complete Data Validation worksheet, where I named my cells D3 

and F3. 

 While you may use the Ifs Practice worksheet to do the following CountIfs and 

AverageIf, you will have to edit the formula bar or Function Arguments box to change your 

criteria. We’ll use our lists and Data Validation for our criteria and the IFS Practice Data 

Validation Worksheet.  

 

Let’s use the COUNTIFS function next. 

1. Now in cell D5, activate your Function Arguments box for the 

COUNTIFS function. We will provide the same criteria as our SUMIFS. 
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2. I use my Insert Function box and 

search for Countifs. 

3. In my Function Arguments box for 

CountIfs, and in the Criteria_range1 

box enter the range name of Customer, 

4. In the Criteria1 box, enter or click 

cell D3, 

 I have named my criteria cell D3 to ClientSelect and my cell F3 to 

PaidSelect.  

5. In Criteria_range 2, enter Paid, 

6. In Criteria2, type or click cell F3, 

7. Click OK. 

8. Now, when you select customers in cell D3 and Yes or No in cell F3, 

we get the sum and the count function. 
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Finally, let’s use the AverageIF function. We’ll use one Criteria and use a Product for our 

Average. 

1. Now, in cell D6, activate your Function Arguments box for the 

AVERAGEIF function. We will provide a single criterion for the 

Average of products by a customer. 

 I have named each of the products Word, Excel, PowerPoint, Outook, and 

Access appropriate names for their column of data.  

2. In the Range box enter Customer,  

3. In the Criteria box enter the cell D3 or use a name (I’ve used 

ClientSelect to represent cell D3), 

4. In the Average range box enter Excel, which will provide an average 

of the client’s purchases of the Excel product, 

5. Click OK. 

6. Excel provides the Average of Excel products for the client in cell D3. 

7. Next, change the Product from Excel to Word using your Formula Bar 

or your Function Arguments box. So, you may change your Average 

function to other products by changing the Average Range name, 

such as Outlook, Access, or Word.  

☹ You cannot use Data Validation or a list for your Average product 

selection. Darn it! You must edit your Formula Bar or Function 
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Arguments box. However, using a name is much easier than entering 

and editing a cell range, like C11 -C99 for your Average range. ☹ 

 

Now, click the Ifs Galore! Tab and notice cells B1, B2, B3, D1, D2, and D3 

with the SUMIFS, AVERAGEIFS, and COUNTIFS functions based on criteria 

and cell ranges.  See how awkward changing our criteria and function 

ranges are without a Data Validation list or using Names.  On your own, 

recreate these functions and provide names and drop-down lists using the 

Ifs Galore! Practice worksheet. 

 

 

 Write your notes here:_________________________________________________________ 

 

________________________________________________________________________ 

 

________________________________________________________________________ 

 

________________________________________________________________________ 
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Security and Worksheet Protection  

Ca l l ing  S ecu r i t y  

Excel has great security options to prevent your workbook file from being edited inappropriately,  

opened or modified by other individuals.  You set these options through your File Tab and the 

Info pane, shortcut menus, or the Review Tab and the Changes Group. There are many ways 

to protect your Excel files and share them.  We are going to concentrate on a couple of options in 

Excel’s protection that prevents editing but is easy to enable editing, require a password to open 

your file and allowing users to edit only parts of a worksheet; otherwise, they will need a 

password to change anything else on the worksheet.  You should play with these different 

options; HOWEVER, always have backup copies of your workbook and worksheets without a 

password – just in case. We will learn a quick and easy way for you to protect your worksheet 

from inappropriate editing, including you. Then, we will look at more extensive password 

protection. 

Ma rk  as  F in a l  

The Office Suite offers a quick and easy way for you to prevent editing and then a quick and 

easy way for you to enable editing; the feature is Mark as 

Final.  We will use your Budget worksheet for these 

exercises. 

1. With your Budget workbook open, click the File 

tab and at the Info pane, click Protect Workbook 

from the cascading menu choose Mark as Final, 

2. The message at right 

appears, click OK, 

3. Next, Excel alerts that 

the workbook is marked 

as final.  
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4. Excel informs you of the Mark as Final status in information box 

underneath the ribbon. 

Notice the box above says discourage, not stop. To me, the reason for Mark 

as Final is so when you or someone else opens the files you don’t accidentally 

start typing over the data and functions. 

5. To enable editing, simply click the Edit Anyway button on your 

information box or return to the File Tab and the Info Pane and click 

the Mark as Final item again to enable editing.   

 

Pa sswo rd  Pro tec t in g  th e  Wo rkbook  -  

En cryp t ion  

You can use the Encrypt document item as displayed below to assign a password to open your 

workbook. This is the strongest form of protection. Here are the steps to activate your Security 

and to set passwords.   

☹ Important Gotcha! When you set a workbook password, Excel warns you to 

remember the password or store the password in a 

secure place; you cannot recover your password if you 

lose or forget it. As I suggested before, I make a back-

up copy of the file without a password in a secure 

folder or other drive and then enter a password for the 

workbook I want to share. ☹ 

1. Open your Budget workbook,  

2. Click the File tab and trace to the Info 

item, 
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3. Click Protect Workbook, and from the cascading menu, click the 

Encrypt with Password item as displayed above, 

4. At the Encrypt the contents of this file and the 

password section type excel123, 

5. Click OK, 

6. Confirm your password by typing excel123, 

7. Save and close your Budget workbook,  

8. Open it and at the password screen enter 

excel123 and press enter or click OK. 

To remove a password, open the Password 

dialogue box through the Protect Workbook and 

the Encrypt with Password item, select and delete 

the password. Click OK.  Deleting the password 

removes the protection.  

Excel has workbook security in the Review Tab, let’s examine 

that. 

1. Open your Budget workbook, 

2. On the Ribbon, click the Review tab, 

3. In the Changes group, click the Protect 

Workbook button. 

4. Notice the areas to protect the Structure 

and Windows.  These prevent copying, 

deleting, or moving worksheets but not the 

information within the worksheets – that’s 

what we will accomplish. 

5. Enter excel123 as your password and then 

re-enter your password to confirm it. Click 

OK. This provides security for the Excel 

Workbook or File, not the worksheet. 

 An Important Gotcha! As I wrote, before, when you set a password, Excel will do 

its best to alert you not to forget the password and will ask you to verify the password 

after initially typing your password.  When Excel says don’t forget the password, 
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Excel means it – unless you want to hire a professional hacker to retrieve your 

password and this is neither cheap nor quick!  

Wo rk sh ee t  Pro tec t ion  a nd  Ce l l  Lo ck ing  

Excel provides a way to only modify certain cells and worksheets, too.  By default Excel has all 

cells locked; in that case, if you protect a worksheet or workbook none of the cells may be 

changed or edited without a password – which is optional.  You may want certain cells or a range 

of cells to be unlocked for you and others so that you can change the contents. 

Here is how you UNLOCK a cell or range of cells. 

1. First select the cell(s) you want people to edit and change, 

2. On the Home Tab click the Dialogue box launcher for Number, 

3. Click the Protection tab and click Locked – so that Locked is NOT 

Checked. 

 An Important Gotcha! You should unlock all the cells you need to and then Protect 

your worksheet or workbook.  

Aside protecting certain cells, you can protect your worksheets, too.  

1. Worksheet Protection is in the Review Tab and the Protect Sheet 

button.  Also, you may right click a worksheet or tab and from the 

shortcut menu choose Protect sheet  

2. You receive a dialog box for the items you want to protect and an 

optional password box.  

3. The items to protect and options will change depending on what you 

are protecting worksheets (individual tabs in your workbook) or the 

workbook (the Excel File).  Use care and caution in setting these 

items. The Excel protection and security features work great; in 

fact, too great if you are not careful or forget a password. 

Although there are several important “gotchas” associated with protection and 

security, I use these a lot to prevent unwanted intrusion and changes in my 

workbooks, worksheets, and cells.  For example, I will provide my clients with a 

pricing sheet of my services.  The clients can change the hours and other aspects of 

the project, but NOT my hourly fee or contracted amount of money!  As an 

Operations Manager, when I set a budget for my groups I would allow them to input 

their expenses but nothing else on the worksheet like we are accomplishing.   
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We will accomplish unprotecting certain cells in our worksheet in this exercise. Let’s Protect 

our January Worksheet except for the Expense items which we will allow changes. 

1. In our Budget workbook, 

2. Click the January tab, 

3. Highlight/Select cells C5 through C14 

– these are the cells we will permit 

people to change.  

4. Click the Home Tab and click the 

Dialogue Box launcher arrow in the 

Number Group or right click the 

selected cells and from the Shortcut 

menu choose Format Cells.  

5. From the Format Cells Dialogue Box,  

click the Protection tab,  

6. Click to uncheck the Locked check 

box, 

7. As pictured here, notice the message of locking our cells and then 

protecting our worksheet. This will be our next step. 

8. Click OK.  

As Excel informed us, nothing has changed about our worksheet yet.  Time to change that – 

we are going to set a password for this sheet and allow only changes to C5 through C14, now. 

1. Click the Review tab and click the Protect sheet button OR right click 

on the January worksheet tab and click the 

Protect Sheet item in the shortcut menu. 

2. The Protect sheet screen appears. In the Allow all 

users of this worksheet to: section only have the 

first two items checked; these are the default.  

Scroll and look at the other options that you may 

allow other uses to change, such as formatting 

and inserting/deleting.  I don’t want others 

changing and destroying my important and 

beautiful work. 



Greg Creech Excelling at Excel: Advanced Level 3  Page 95 

www.gregcreech.com 

Greg Creech © 2018 Techedutainment Services, Inc.  Thank you for Learning! 

404-299-1706  No Duplication Permitted 

3. Let’s give an optional Password of excel123 (Case matters! I’m using 

lowercase), 

4. Click OK, 

5. A Dialogue box appears asking you to confirm 

the password retype excel123 and read the Caution 

message. 

6. Click OK, and  Excel returns to your worksheet. 

Try to change numbers in the budget column or 

anywhere other than cells C5 through C14.  You’ll 

receive the error message displayed here.  

Try to format your heading with a different font, size,  or color.  Excel acts 

like it will change these for you, but alas it won’t. 

Click in cell C5 and change the number.  You are allowed to do this because 

we unlocked our cells before we protected our sheet.  You can change and 

edit any of the items in C5 through C14 but nowhere else. 

Let’s  remove the protection. 

1. In the Review Tab,  

2. Click the Unprotect Sheet button, 

3. In the Password dialogue box, type excel123. Our worksheet is 

unprotected and we are free to make any changes, again. 

 

 An Important Gotcha! If we had wanted to protect these cells on all of our 

worksheets we would need to have accomplished this and then copy the worksheets.  

As our workbook is now, we would have to go through each tab and set the protection 

on each one.  Grouping your sheets and trying to set passwords on specific cells won’t 

work.  If you have several worksheets selected or grouped when you unlock your cells 
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and protect your workbook, the worksheets are not protected from input ONLY THE 

STRUCTURE OF THE WORKSHEETS ARE PROTECTED; therefore, no one can 

delete, copy, or otherwise change the structure or layout of your workbook.  You 

would need to unlock the cells first, then protect your worksheet, and finally, copy it 

as we learned earlier in this course.  

 

 

 Write your notes here:_________________________________________________________ 

 

________________________________________________________________________ 

 

________________________________________________________________________ 

 

________________________________________________________________________ 
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Charts: As Easy As Pie  

Ch ar t  Ar t  

No Excel course ise complete without a look at charts.  Charts are graphical, visual 

representation of our data.  Charts turn our number crunching into a work of art.  We will build 

a Pie Chart and a Column Chart in the next sections.  We’ll look at some of the new charts in 

Excel 2016. We’ll learn the Chart contextual tabs and other panes to create dynamic and 

appealing charts.   

A Hot Tip!  Always select the area of the worksheet that you 

want to base your chart upon.  If you don’t select your area, 

Excel assumes your table and may include totals and other 

data you do not want.  

Two Quick Chart Shortcuts: 

1. The Function 11 (F11) key quickly produces a column 

chart for you in a new worksheet, 

2. After selecting your area, you may use the Quick 

Analysis menu to add a chart. To use the Quick Analysis 

menu your chart areas must be continuous, so we can’t 

use the Quick Analysis in our exercise below, since we 

are selecting two different areas of the worksheet.  

1. Open the Budget workbook, 

2. Click the January Tab.  We want to select two 

different areas – our items and our expenses.  

Here’s how: 

3. Select cells A4 through A14, 

4. Press your CTRL key and click and drag cells C4 

through C14 to select them. We want a pie chart to 

display where our money goes by item. 

5. Click the Insert Tab, 
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6. Click the Pie Chart button and from the 

cascading menu choose the 3-D Pie Chart. 

Notice Excel provides a nice preview of your 

chart.   

7. Excel inserts a Pie Chart in your worksheet and 

opens your Chart Tools at the Design Tab. 

8. Scroll through the Chart Styles and choose one. 

I am choosing Style 3 with a Legend and Percentages. 

 

 

 

 

 

 

 

 

 

 

Let’s put this chart in its own worksheet and change some elements. 

1. On the Design Tab at the end of the row 

of command buttons, click the Move 

Chart button and in the Move Chart 

Dialogue Box, click the New Sheet item 

and give the new worksheet a name, 

such as January Expenses, 

2. Click OK.  

3. Excel moves your chart to a new 

worksheet named January Expenses. 
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The new vesions of Excel 2013/2016 use fly-out 

menus instead of the Layout Tab in previous 

versions of Excel to accomplish customizing your 

chart. 

1. With your January Expenses pie chart 

displayed, move your cursor to the upper right 

area and three items appear. The top item is the 

plus sign (+) for you to change your Chart 

Elements. I am moving my Data Labels to the 

Outside End. 

2. Next, I move my Legend to the Top of my Chart Area.  

3. Click in the chart title Expenses and change the title 

to January Expenses. You may select your text and the 

Mini Toolbar appears with many of your formatting 

options. 

Let’s look at some of the color schemes for our charts and customize the color for a chart 

item. 

You may use your Chart Tools’ 

Design Tab and the Color button to 

change your color scheme. You may 

change your layout, too, using the 

Quick Layout button and menu. 

I am using the format item on the chart – the paint brush and 

middle item. There are many ways to format and customize your 

chart elements, including the Format Tab for Charts. 

 

1. Click the Format Tab – this tab displays below. 
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2. Click your Chart – notice how Excel puts little circles around each piece 

of your Pie – this indicates that these areas are selected for you and 

any formatting change you make to one affects all of the pieces.  

 An Important Gotcha: If you change your chart’s color with all of 

the pieces selected the chart will be the same color and more difficult 

to see your categories. The Current Selection group at the beginning of 

your Layout Tab Row will display what you have selected and what 

other areas you may quickly select. The Format Selection button 

activates your Formatting Options task pane.   

3. Click one of your pieces of your pie again and notice how 

Excel now only puts little circles around that piece of your pie, so any 

changes you make only affects that piece of your pie.  

4. Click this piece of your pie and drag it out.  Excel moves this piece out 

and reshapes your pie.  

5. Using your Shape Styles group change the Fill 

Color of this piece of your pie.  

6. Notice from the Shape Fill cascading menus all 

of the options available for you – you may even 

use a picture as a background or fill color for 

pieces of your Pie chart.  Look at difference 

options and play around. 

7. Save your workbook.  

Additional Formatting changes. 

As displayed at right I have made additional 

formatting changes and I have used my Mini 

Toolbar and Shortcut menu to help me make 

changes.  On your own, make these changes: 

✓ Bold all of your labels – Click one label or percentage and Excel 

selects all of them. Next, use your mini toolbar or Home tab to bold 

your percentages. 

✓ Move only certain labels (You’ll have to click a label and Excel selects 

all of the labels for you, then click a specific label and Excel will select 

the label by putting circles around that label and no other label). 
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✓ Change your Legend’s font, font size, and make your Legend larger. 

✓ Don’t forget, if you right click on a chart element, a nifty shortcut 

menu displays offering you many of these options. 

✓ Play and use your creativity. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Another nice thing about charts is, as you make changes to your January worksheet, the chart 

automatically updates. 

1. Click on your January worksheet tab, 

2. Change Lease expense cell C5 to $2,000, press the Enter key. 

3. Click the January Chart tab.  The Lease Data Point reflects the 

change. 

4. Change your Lease expense back to $1050.00 and the chart changes, 

too. 
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Ch ar t ing  an o th er  Char t  
Let’s create another chart, one more time and learn other options with formatting and 

enhancing our charts.  We want to compare our Budget and Expenses by Category using a 

Column Chart and then we will copy this and use other types of charts and options. 

Have your Budget workbook open. 

1. Go to your January worksheet, 

2. Click and drag to select A4 through 

C14, 

3. Click your Quick Analysis button and 

from the menu choose charts and then 

Clustered Column Chart. Excel provides 

a preview of your chart.  

4. Excel inserts a Column chart illustrating 

your Budget and Expenses. 

Not sure if that is the chart you want? Click 

the Change Chart Type button and a menu 

appears with two tabs. The Recommended 

Charts Tab displays charts that match your 

selection, and  All Charts displays more 

chart types than you could think. Click 

different types of charts and Excel gives you 

a preview of the chart.  

5. Move your chart by click on the border 

of your chart and dragging it to a new 

location – I have put my chart under 

my data area, 

6. Make your chart larger by placing your 

cursor over one of the corners and 

with the double headed arrow clicking 

and dragging out, 

7. With your Design Tab active in the Chart Tools’ contextual tab, 

change your layout using the Quick Layout button and menu.  I have 
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chosen Layout 9 with Chart Title, Legend at right, with 

Axis and Titles, and Major Gridlines. 

8. Next, change your Chart Style using the Chart Style 

Gallery of colors and formats, 

9. Click in the Chart Title area and type Budget vs 

Expenses, 

10. Select your Chart Title text and  right click in your 

Chart Title and from the Mini Toolbar change your Chart 

Title Formatting. I have changed my font, font color, fill 

color a border around my title. 

 

As with the Pie chart, let’s change and format our chart items and objects. 

1. Since I have Axis titles, I have 

changed the Value axis title to Monthly 

Amount and the Category axis to 

Categories of Expenses. 

2. Right click your Value Axis and from 

the shortcut menu click Format Axis  …  

3. The Format Axis Task Pane opens at 

the right of your screen. Click the Number 

item and expand your options, change 

your number’s decimal place to 0. 

4. Next, in Units for Major I have 

changed mine to 500.  You have many options 

using this task pane, and besides the Axis 

Option tab, you have the Text Options that you 

may use.  

The Format Axis Task Pane makes it easy to 

navigate to other chart elements to customize. 

When you click the Axis Options arrow, you 

receive a list of other Chart elements. I am 
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navigating to my Legend to put it at the bottom of my chart. 

5. You may close your Format Options Task Pane by clicking the X at the 

top right of the pane. Notice, you don’t have to click OK or save to 

change your chart elements. As you use the Task Panes, your chart 

changes automatically for you. 

Let’s change your column colors. 

1. Click one of your columns, and Excel selects all of your 

columns by placing little circles around each column,  

2. Right Click one of the Columns and from the shortcut 

menu choose Format Data Series.  The Format Data 

Series Task pane opens. 

3. Like other Format Task Panes, this one is loaded with 

options. I am changing my Fill color. You may use the 

other Series Effects and Series Options buttons at the 

top of the pane, too.  

4. Click your other column to select those columns and 

format that data series. Using my Format Tab in Chart 

Tools and the Format Data Series panes, I have 

changed fill color, and other items – change your 

column as you wish. 

5. Right click in your Category Axis and from the shortcut menu add 

Major Gridlines.  

6. Click and drag your chart title to move it to new location. 

Let’s look at our Chart Element button and make a couple of changes there. 

We have used the Format tab to make many of our changes and the Format 

Options Task Pane. We can use shortcut menus or the Chart Element 

buttons on the chart. 
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1. Click the Chart Elements  (+) button on the upper 

right area of your chart. I navigate to Gridlines and turn 

on my Primary Major Vertical gridlines.  

2. Click the Data Labels and view your labels – I turned 

mine off, because it made my chart too busy. 

3. Next, using your Chart elements pane, add a 

Trendline. 

Let’s look at other types of charts. 

We want to keep this chart but examine some of Excel’s 

other great charts.  First, let’s copy this chart to a new 

worksheet and then look at other charts, like Area, Bar, 

and Line Charts. 

 

1. Right click in your Chart Area and from the shortcut menu choose 

copy. Next, paste the chart in another area of your worksheet or in 

a new workbook. 

2.  Click your Design Tab of your Chart Tools, 

3. Click the Change Chart Type button, 

4. The Change Chart Type Gallery pane opens for you to click a type 

of chart and then a style for that chart, 

5. I am using the All Charts tab and select the 

new Waterfall chart. You should go through and 

look at all of the interesting ways of displaying 

your data. 

6. Select a new chart type and click OK. 

7. Excel changes your chart and keeps many of 

your formatting changes. 
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Ch ar t  F i l t e r s  a nd  D a ta  Op t ion s  

Charts have a Filter button that works just like our previous filtering. 

The Filter button is in upper right corner of your chart with the Chart 

Elements and Chart Styles button as displayed here.  

 

You may use the Select Data button on your Design Tab and the 

dialogue box below displays, where you may use filters. Using this pane 

you may change the chart’s data area and switch rows/columns and 

perform other helpful actions.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Write your notes here:_________________________________ 
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An Excellent Excel  Index  
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=TODAY(), 16 

3 

3-D References, 9 

A 

Absolute Address, 9 
Absolute Formula, 19 
Automatic Conditional Formatting, 30 

B 

Button Symbol, 55 

C 

Category Axis, 104 
Cell Locking, 93 
Cell Referencing, 9 
Chart Style Gallery, 103 
Chart Tools, 102 
Chart Type Gallery, 105 
Charts, 97 
Client List, 41 
Column Chart, 102 
Concatenate, 56 
Conditional Formatting, 26, 27 
Create Names From Selection, 35 
Custom Conditional Formatting, 26 

D 

Data Validation, 36 
Date Calculations, 64 
Date Validation, 39 
Define Name, 35 
Defined Names, 35 
Design Tab, 105 
Developer Tab, 45, 46 

E 

Edit A Macro, 53 

Editing A Macro, 52 
Encrypt, 91 
Encrypt Document, 92 
Error Alert, 39 
Excel Shortcuts, 6 

F 

Format Axis, 103 
Format Data Series, 104 
Formatting Macro, 47 
Formulas, 7, 8 

H 

Hide, 53 
HLOOKUP, 67, 76 

I 

If, 77 
If, Then, Else, 77 
IFERROR Function, 72 
Input Message, 39 

L 

Linkage, 23 
List, 41 
Locked Check, 94 
Lookups, 66 

M 

Macro Enable Workbooks, 45 
Macro Security, 51 
Macros, 45 
Macros Assignment, 54 
Mark As Final, 90 
Mathematical Operators, 7 
Mini Toolbar, 100 
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N 

Name Box, 32 
Name Manager, 34 
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P 

Password, 95 
Personal Macro Workbook, 47, 52 
PERSONAL.XLSB, 53 
Pie Chart, 97 
Printing Macro, 49 
Protect Sheet, 93 
Protection, 93 

R 

Record Macro Button, 49 
Record Macro Button, 50 
Record Macro Dialogue Box, 46 
Relative Address:, 9 
ROUNDDOWN, 65 

S 

Security, 91 

Settings, 39 
Sorting Macro, 50 
Stop Recording, 50 

T 

TODAY(), 64 

U 

Unhide Button, 53 
UNLOCK A Cell, 93 
Unprotect Sheet, 95 

V 

VLOOKUP, 67, 68, 73 
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Worksheet Protection, 93 

 


